**WEEE Compliance**

This product is required to comply with the European Union’s Waste Electrical & Electronic Equipment (WEEE) Directive 2002/96/EC. It is marked with the following symbol:

![WEEE Symbol](image)

Thermo Fisher Scientific has contracted with one or more recycling/disposal companies in each EU Member State, and this product should be disposed of or recycled through them. Further information on Thermo Fisher Scientific’s compliance with these Directives, the recyclers in your country, and information on Thermo Fisher Scientific products which may assist the detection of substances subject to the RoHS Directive are available at [www.thermo.com/WEEERoHS](http://www.thermo.com/WEEERoHS).

---

**WEEE Konformität**

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC erfüllen. Das Produkt ist durch folgendes Symbol gekennzeichnet:

![WEEE Symbol](image)

**Conformité DEEE**

Ce produit doit être conforme à la directive européenne (2002/96/EC) des Déchets d’Equipements Electriques et Electroniques (DEEE). Il est marqué par le symbole suivant:

![Symbole DEEE](image)

Read This First

Welcome to the Thermo Scientific, LTQ Orbitrap XL™ system! The LTQ Orbitrap XL is a member of the family of LTQ™ mass spectrometer (MS) detectors.

About This Guide

This LTQ Orbitrap XL Getting Started manual provides you with information on how to set up, calibrate, and tune the LTQ Orbitrap XL. Procedures in Chapters 1–4 can be performed from the Xcalibur™ Tune Plus window.

Who Uses This Guide

This LTQ Orbitrap XL Getting Started manual is intended for all personnel that need to operate the LTQ Orbitrap XL, especially the key operator. This manual should be kept near the instrument to be available for quick reference.

Scope of This Guide

LTQ Orbitrap XL Getting Started includes the following chapters:

• Chapter 1: “Introduction” provides general information about this manual.

• Chapter 2: “Tune Plus Window” provides information on the Tune Plus window.

• Chapter 3: “Calibrating the Instrument for FTMS Measurements” provides procedures to calibrate your LTQ Orbitrap XL for FTMS measurements.

• Chapter 4: “Performing Diagnostics/Checks” describes several diagnostic procedures.

• Chapter 5: “Instrument Setup” describes the FTMS relevant topics of the data dependent settings in the Instrument Setup.

• Chapter 6: “Instrument Configuration” gives instructions about configuring your instrument.
• **Chapter 7: “MALDI LTQ Orbitrap Series Instruments”** describes the Orbitrap relevant differences in instrument settings and procedures with respect to using a MALDI source.

• **Chapter 8: “LTQ Orbitrap XL ETD Instruments”** describes the Orbitrap relevant differences in instrument settings and procedures with respect to using a LTQ Orbitrap XL ETD instrument.

• **Appendix A: “Miscellaneous Information”** gives additional information about various topics.
Related Documentation

In addition to this guide, Thermo Fisher Scientific provides the following documents for LTQ Orbitrap XL / LTQ Orbitrap XL ETD:

- *LTQ Orbitrap XL / LTQ Orbitrap Discovery Preinstallation Requirements Guide*

- *LTQ Orbitrap XL Hardware Manual or LTQ Orbitrap XL ETD Hardware Manual*

- LTQ XL manual set

- *MALDI Source Getting Started*

- *MALDI Source Hardware Manual*

The software also provides Help.
Contacting Us

There are several ways to contact Thermo Fisher Scientific.

Assistance

For technical support and ordering information, visit us on the Web:

www.thermo.com/advancedms

Customer Information Service

cis.thermo-bremen.com is the Customer Information Service site aimed at providing instant access to

• latest software updates
• manuals, application reports, and brochures.

Note Thermo Fisher Scientific recommends that you register with the site as early as possible.

To register, visit register.thermo-bremen.com/form/cis and fill in the registration form. Once your registration has been finalized, you will receive confirmation by e-mail.

Changes to the Manual

❖ To suggest changes to this manual

• Please send your comments (in German or English) to:

  Editors, Technical Documentation
  Thermo Fisher Scientific (Bremen) GmbH
  Hanna-Kunath-Str. 11
  28199 Bremen
  Germany

• Send an e-mail message to the Technical Editor at

documentation.bremen@thermofisher.com

You are encouraged to report errors or omissions in the text or index. Thank you.
Typographical Conventions

This section describes typographical conventions that have been established for Thermo Fisher Scientific manuals.

Data Input

Throughout this manual, the following conventions indicate data input and output via the computer:

- Messages displayed on the screen are represented by capitalizing the initial letter of each word and by italicizing each word.
- Input that you enter by keyboard is identified by quotation marks: single quotes for single characters, double quotes for strings.
- For brevity, expressions such as “choose File > Directories” are used rather than “pull down the File menu and choose Directories.”
- Any command enclosed in angle brackets < > represents a single keystroke. For example, “press <F1>” means press the key labeled F1.
- Any command that requires pressing two or more keys simultaneously is shown with a plus sign connecting the keys. For example, “press <Shift> + <F1>” means press and hold the <Shift> key and then press the <F1> key.
- Any button that you click on the screen is represented in bold face letters. For example, “click on Close”.

Topic Headings

The following headings are used to show the organization of topics within a chapter:

Chapter 1 Chapter Name

Second Level Topics

Third Level Topics

Fourth Level Topics
Safety and EMC Information

In accordance with our commitment to customer service and safety, these instruments have satisfied the requirements for the European CE Mark including the Low Voltage Directive.

Designed, processed, and tested in an ISO9001 registered facility, this instrument has been shipped to you from our manufacturing facility in a safe condition.

This instrument must be used as described in this manual. Any use of this instrument in a manner other than described here may result in instrument damage and/or operator injury.

Notice on Lifting and Handling of Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Scientific instrument requires a team effort for lifting and/or moving the instrument. This instrument is too heavy and/or bulky for one person alone to handle safely.

Notice on the Proper Use of Thermo Scientific Instruments

In compliance with international regulations: If this instrument is used in a manner not specified by Thermo Fisher Scientific, the protection provided by the instrument could be impaired.

Notice on the Susceptibility to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency transmitters, such as mobile phones, in close proximity to the instrument.

Safety and Special Notices

Make sure you follow the precautionary statements presented in this guide. The safety and other special notices appear different from the main flow of text. Safety and special notices include the following:

Warning Warnings highlight hazards to human beings. Each Warning is accompanied by a Warning symbol.

Caution Cautions highlight information necessary to protect your instrument from damage.

Note Notes highlight information that can affect the quality of your data. In addition, notes often contain information that you might need if you are having trouble.
Identifying Safety Information

The LTQ Orbitrap XL Getting Started contains precautionary statements that can prevent personal injury, instrument damage, and loss of data if properly followed. Warning symbols alert the user to check for hazardous conditions. These appear throughout the manual, where applicable. The most common warning symbols are:

**Warning** This general symbol indicates that a hazard is present that could result in injuries if it is not avoided. The source of danger is described in the accompanying text. ▲

**Warning** High Voltages capable of causing personal injury are used in the instrument. The instrument must be shut down and disconnected from line power before service is performed. Do not operate the instrument with the top cover off. Do not remove protective covers from PCBs. ▲

**Warning** Treat heated zones with respect. Parts of the instrument might be very hot and might cause severe burns if touched. Allow hot components to cool before servicing them. ▲

**Warning** Wear gloves when handling toxic, carcinogenic, mutagenic, or corrosive/irritant chemicals. Use approved containers and procedures for disposal of waste solution. ▲

**Warning Laser Radiation** Avoid eye or skin exposure to direct or scattered radiation! ▲

In addition to the above described, every instrument has specific hazards. So, be sure to read and comply with the precautions described in the subsequent chapters of this guide. They will help ensure the safe, long-term use of your system.

General Safety Precautions

Observe the following safety precautions when you operate or perform service on your instrument:

- Before plugging in any of the instrument modules or turning on the power, always make sure that the voltage and fuses are set appropriately for your local line voltage.
• Only use fuses of the type and current rating specified. Do not use repaired fuses and do not short-circuit the fuse holder.

• The supplied power cord must be inserted into a power outlet with a protective earth contact (ground). When using an extension cord, make sure that the cord also has an earth contact.

• Do not change the external or internal grounding connections. Tampering with or disconnecting these connections could endanger you and/or damage the system.

• The instrument is properly grounded in accordance with regulations when shipped. You do not need to make any changes to the electrical connections or to the instrument’s chassis to ensure safe operation.

• Never run the system without the housing on. Permanent damage can occur.

• Do not turn the instrument on if you suspect that it has incurred any kind of electrical damage. Instead, disconnect the power cord and contact a service representative for a product evaluation. Do not attempt to use the instrument until it has been evaluated. (Electrical damage may have occurred if the system shows visible signs of damage, or has been transported under severe stress.)

• Damage can also result if the instrument is stored for prolonged periods under unfavorable conditions (e.g., subjected to heat, water, etc.).

• Always disconnect the power cord before attempting any type of maintenance.

• Capacitors inside the instrument may still be charged even if the instrument is turned off.

• Never try to repair or replace any component of the system that is not described in this manual without the assistance of your service representative.

• **Shut Down the Laser Before You Perform any Service on the MALDI Source.** The MALDI source uses a high-energy ultraviolet laser capable of causing personal injury. Do not operate the source with the cover off the sample module.

• Do not place any objects – especially not containers with liquids – upon the instrument. Leaking liquids might get into contact with electronic components and cause a short circuit.
Safety Advice for Possible Contamination

Hazardous Material Might Contaminate Certain Parts of Your System During Analysis.

In order to protect our employees, we ask you to adhere to special precautions when returning parts for exchange or repair.

If hazardous materials have contaminated mass spectrometer parts, Thermo Fisher Scientific can only accept these parts for repair if they have been properly decontaminated. Materials, which due to their structure and the applied concentration might be toxic or which in publications are reported to be toxic, are regarded as hazardous. Materials that will generate synergetic hazardous effects in combination with other present materials are also considered hazardous.

Your signature on the Repair-Covering letter confirms that the returned parts have been decontaminated and are free of hazardous materials.

The Repair-Covering letter can be ordered from your service engineer or downloaded from the Customer Information Service (CIS) site. Please register under http://register.thermo-bremen.com/form/cis.

Parts contaminated by radioisotopes are not subject to return to Thermo Fisher Scientific – either under warranty or the exchange part program. If parts of the system may be possibly contaminated by hazardous material, please make sure the Field engineer is informed before the engineer starts working on the system.
Contents

Chapter 1  Introduction................................................................................1-1

Chapter 2  Tune Plus Window....................................................................2-1
  Preliminary Remarks........................................................................... 2-2
  View Menu ....................................................................................... 2-3
    Spectrum View............................................................................... 2-3
    Graph View ................................................................................... 2-5
    Status View ................................................................................. 2-5
  Control Menu................................................................................... 2-8
    Advanced Calibration Features....................................................... 2-8
  Scan Mode Menu............................................................................... 2-9
    Define Scan.................................................................................... 2-9
    Scan Ranges .................................................................................. 2-15
    Centroid/Profile............................................................................. 2-15
    Positive/Negative ......................................................................... 2-16
  Display Menu .................................................................................... 2-17
    Spectrum Averaging ...................................................................... 2-17
  Setup Menu ....................................................................................... 2-18
    FT Transfer Optics ....................................................................... 2-18
    FT Injection Control ..................................................................... 2-19
    FT Vacuum .................................................................................... 2-21
    FT Temperature Monitor ............................................................... 2-22
    FT Lock Masses ............................................................................ 2-22
  Tune Methods ................................................................................... 2-23
    Parameters with Differentiation between Ion Trap
    and FT Scans ................................................................................ 2-23
    Parameters without Differentiation between Ion Trap
    and FT Scans ................................................................................ 2-24
    Parameters not saved in a Tune Method .......................................... 2-24

Chapter 3  Calibrating the Instrument for FTMS Measurements........3-1
  Preliminary Remarks......................................................................... 3-2
  Calibration Files and their Backups.................................................. 3-3
    Backup Current Calibration............................................................. 3-3
    Restore Backup Calibration............................................................ 3-3
  Calibration Solutions........................................................................ 3-4
    Obtaining Ready-to-Use Calibration Solutions ... 3-4
    LTQ/FT-Hybrid Positive Ion Mode Calibration
    Solution ......................................................................................... 3-5
    LTQ/FT-Hybrid Negative Ion Mode Calibration
    Solution ......................................................................................... 3-7
Contents

Applicable Calibration Solutions for FT Manual Calibration ................................................. 3-8
Calibration and Tuning of the Ion Trap ............................................................. 3-9
Calibration of the Ion Trap .................................................................................. 3-9
Tuning the Ion Trap for Positive Ion Mode ......................................................... 3-9
Tuning the Ion Trap for Negative Ion Mode ......................................................... 3-11
Automatic Calibration Page .............................................................................. 3-13
Semi-Automatic Calibration Page ....................................................................... 3-15
HCD Calibration ............................................................................................... 3-16
Advanced Calibration Features ......................................................................... 3-17
Check Calibration Page ....................................................................................... 3-18
FT Manual Calibration Page ................................................................................ 3-21
Mass List Group Box .......................................................................................... 3-22

Chapter 4 Performing Diagnostics/Checks .......................................................... 4-1

System Evaluation Procedures ........................................................................... 4-2
FT Dynamic Range Test .................................................................................... 4-2
FT Energy Dependence Evaluation .................................................................. 4-2
FT HCD Collision Cell Ejection Evaluation ...................................................... 4-3
FT High Mass Range Target Compensation .................................................... 4-3
FT Isolation Test ............................................................................................... 4-3
FT Noise Test .................................................................................................. 4-3
FT Preamp Evaluation ....................................................................................... 4-3
FT Pulser Evaluation ........................................................................................ 4-4
FT Sensitivity Test ............................................................................................. 4-4
FT Stability Test ............................................................................................... 4-4
FT Temperature Control Evaluation ................................................................. 4-5
FT Temperature Monitor .................................................................................... 4-5
Toggles ............................................................................................................... 4-6
FT Analyzer Ion Gauge ..................................................................................... 4-7
FT Analyzer Temperature Control .................................................................... 4-7
FT Apodization .................................................................................................. 4-7
FT HCD Collision Gas ....................................................................................... 4-7
FT Include Transients ....................................................................................... 4-7
FT Manual Calibration for Single Range ........................................................... 4-8
FT Profile Mode ................................................................................................. 4-8
FT SIM and MSn Injection Waveforms ............................................................... 4-8
FT Storage Evaluation Mode .............................................................................. 4-8
FT Storage Multipole RF ................................................................................... 4-9
FT Transfer Multipole RF ................................................................................ 4-9
FT View Frequency ........................................................................................... 4-9
FT Zero Offset ................................................................................................. 4-9
Set Device ........................................................................................................ 4-10
FT Lockmass Abundance ................................................................................... 4-11
FT Mass Check Test Duration ........................................................................... 4-11
Setting new FT Transfer Optics Parameters ...................................................... 4-11
Display Settings ................................................................................................. 4-12
Display FT Calibration Settings ....................................................................... 4-12
Display FT Diagnostics ..................................................................................... 4-12
Chapter 5 Instrument Setup ........................................... 5-1
Using Locking in Automated Runs ................................ 5-2
Data Dependent Settings .............................................. 5-3
Using Masses instead of Mass-to-Charge Ratios .......... 5-3
Preview Mode .............................................................. 5-6
Monoisotopic Precursor Selection ............................... 5-7
Use Non-Peptide Monoisotopic Recognition .................. 5-8
Data Dependent FT SIM Scans ..................................... 5-8
Activation Type ........................................................... 5-11
FT HCD .................................................................... 5-12
MSn Settings for HCD Experiments .............................. 5-13

Chapter 6 Instrument Configuration .................................. 6-1
Starting Instrument Configuration .................................. 6-2
FT Settings Page .......................................................... 6-3
FT Mass Lists Page ........................................................ 6-4

Chapter 7 MALDI LTQ Orbitrap Series Instruments .............. 7-1
Tune Plus Window ....................................................... 7-2
Status View ............................................................... 7-2
Scan Mode Menu ......................................................... 7-3
Define Scan Dialog Box ............................................... 7-3
Setup Menu ............................................................... 7-4
Injection Control Dialog Box - FT Page ....................... 7-4
MALDI Source Dialog Box ............................................. 7-4
Calibrating MALDI LTQ Orbitrap Series Instruments .... 7-8
ProteoMass MALDI Calibration Kit ............................... 7-8
Calibrating the Instrument for MALDI ......................... 7-10
Diagnostics for MALDI ................................................ 7-16
Instrument Setup ........................................................ 7-18
Using Locking in Automated Runs ............................... 7-18
Instrument Configuration ............................................ 7-19
Starting Instrument Configuration ............................... 7-19
Instrument Configuration Dialog Box ......................... 7-20
MALDI Source Configuration Dialog Box ...................... 7-21

Chapter 8 LTO Orbitrap XL ETD Instruments .................... 8-1
Tune Plus Window ....................................................... 8-2
Status View ............................................................... 8-2
Scan Mode Menu ........................................................ 8-3
Setup Menu ............................................................... 8-4
Reagent Ion Source Dialog Box .................................... 8-5
Configuring the Reagent Ion Source ......................... 8-8
Powering On the ETD Module and Viewing Reagent Ion Spectra ........................................ 8-10
Powering On the ETD Module ........................................ 8-10
Turning On the Reagent Ion Source and Viewing Reagent Ion Spectra ........................................ 8-10
Viewing Reagent Ion Spectra ........................................ 8-11
Tuning the ETD Optics .................................................. 8-12
Autotuning The Reagent Ion Source ......................... 8-12
Manually Tuning the Reagent Ion Source .................. 8-14
Viewing the Current Reagent Ion Optics Settings ...... 8-17
Saving Your ETD Tune Method ................................. 8-18
Tuning the Quadrupole Mass Filter .......................... 8-18
Performing an ETD Infusion Experiment ................... 8-25
Injection Control: Reagent Ion AGC Target and Ion Time Settings ........................................ 8-25
Obtaining an ETD Spectrum for Angiotensin I .......... 8-26
Optimizing the Reagent Ion Reaction Time ............... 8-29
Creating an Xcalibur Instrument Method That Uses ETD Activation ..................................... 8-33
Angiotensin I Solutions .............................................. 8-39
Preparing the Angiotensin I Stock Solution .......... 8-39
Preparing the Angiotensin I Test Solution ............. 8-40

Appendix A Miscellaneous Information ......................... A-1
FT Analyzer Information in Scan Header .................... A-2
FT Analyzer Settings ............................................. A-2
FT Analyzer Messages ............................................ A-3
Data Size of FT Raw Files ...................................... A-4

Glossary ..................................................................... G-1

Index ......................................................................... I-1
Figures

Tune Plus window ................................................................. 2-2
Spectrum View page ............................................................. 2-3
Spectrum Display Options dialog box – FT page ..................... 2-4
Graph view page .................................................................. 2-5
Status view – All page .......................................................... 2-6
User Status Display Configuration dialog box ......................... 2-7
Define Scan dialog box (Advanced Scan Features enabled) .......... 2-9
Scan Time Settings dialog box – FT page ............................... 2-12
Lock Masses dialog box ........................................................ 2-13
Define Scan dialog box with HCD selected as activation type .... 2-15
Spectrum Averaging dialog box ............................................. 2-17
FT Transfer Optics dialog box .............................................. 2-18
Ion Trap page of the Injection Control dialog box .................... 2-19
FT page of the Injection Control dialog box ............................ 2-20
Ion Trap page of the Vacuum dialog box ............................... 2-21
FT page of the Vacuum dialog box ....................................... 2-21
FT Temperature Monitor dialog box ...................................... 2-22
Recommended settings in the Define Scan dialog box for an
automatic tune of the ion trap ................................................. 3-10
Ion trap spectrum of positive ion mode calibration solution, scan
range m/z 130–2000, positive ion polarity mode ....................... 3-11
Ion trap spectrum of the negative ion mode calibration solution,
scan range m/z 150–2000, negative ion mode ........................... 3-12
Automatic page of the Calibrate dialog box ............................. 3-13
Semi-Automatic page of the Calibrate dialog box ..................... 3-15
Semi-Automatic page of the Calibrate dialog box (Advanced
Calibration Features enabled) ............................................... 3-17
Check page of the Calibrate dialog box .................................... 3-18
FT Manual page of the Calibrate dialog box ......................... 3-21
System evaluation page of the Diagnostics dialog box ................ 4-2
Result of the FT stability test displayed in the Graph View ........... 4-5
Toggles page of the Diagnostics dialog box ............................. 4-6
Set device page of the Diagnostics dialog box ......................... 4-10
Display settings page of the Diagnostics dialog box .................. 4-12
MS Detector Setup View – MS Detector Setup Page .................. 5-2
Data Dependent Settings dialog box – Global page .................. 5-3
Data Dependent Settings dialog box – Current Segment page .... 5-6
Data Dependent Settings dialog box – Charge State page
(Advanced Features on) ...................................................... 5-7
Data Dependent Settings dialog box – Current Scan Event page ... 5-8
Current Scan Event page – Repeat previous scan event with
HCD .................................................................................. 5-9
Data Dependent Settings dialog box – Scan Widths page .......... 5-10
Data Dependent Settings dialog box – Activation page ....................... 5-11
Data Dependent Settings dialog box – FT HCD page ......................... 5-12
MS Detector Setup Page – Scan event settings with HCD experiment ............................................................... 5-13
Instrument Configuration dialog box .............................................. 6-2
LTQ Orbitrap XL Configuration dialog box – FT Settings page ............. 6-3
LTQ Orbitrap XL Configuration dialog box – FT Mass Lists page .......... 6-4
Status View for MALDI LTQ Orbitrap Series instrument .................. 7-2
Define Scan dialog box for MALDI ..................................................... 7-3
FT injection control settings for MALDI ............................................ 7-4
MALDI Source dialog box – Control page ........................................ 7-5
MALDI Source dialog box – Plate Setup page ................................... 7-6
MALDI Source dialog box – Acquire page ........................................ 7-7
Semi-automatic calibration page, Normal Mass Range ...................... 7-10
Mass calibration of the Small Mass Range ....................................... 7-11
Mass calibration of the Universal Mass Range ............................... 7-12
Semi-automatic calibration page, High Mass Range ......................... 7-12
Checking the mass calibration (Normal Mass Range) ...................... 7-13
Calibrate dialog box – FT Manual page: Normal Mass Range (NMR) ........................................................................... 7-14
Calibrate dialog box – FT Manual page: High Mass Range (HMR) ............................................................................... 7-15
MALDI page of the Diagnostics dialog box ...................................... 7-16
Video Camera Contrast and Brightness Test .................................... 7-17
Instrument Setup window for MALDI LTQ Orbitrap Series instrument .................................................................................. 7-18
Instrument Configuration window .................................................. 7-19
LTQ Orbitrap Series Configuration dialog box – Ion Source page ....... 7-20
LTQ Orbitrap Series Configuration dialog box – Display page ........... 7-21
MALDI Source Configuration dialog box ......................................... 7-21
Status View for LTQ Orbitrap XL ETD ............................................. 8-2
Define Scan dialog box for LTQ Orbitrap XL ETD .......................... 8-3
Injection Control dialog box – Reagent page ................................... 8-4
Activating Reagent Ion Optics dialog box ....................................... 8-5
Reagent Ion Source dialog box ......................................................... 8-6
Reagent page of the Vacuum dialog box ......................................... 8-7
Enabling the reagent ion source ...................................................... 8-8
LTQ Orbitrap Series Configuration dialog box – Reagent Ion Source page ............................................................................... 8-9
Message box: Reagent Vial NOT At Temperature! ........................... 8-10
Tune Plus window showing the fluoranthene radical anion mass spectrum ................................................................................. 8-11
Activating Reagent Ion Source tuning .............................................. 8-12
Tune Plus window with Automatic page of Tune dialog box displayed ......................................................................................... 8-13
Tune Plus window with Reagent Ion Optics dialog box .................... 8-15
Reagent Ion Source Tune dialog box – Manual page ......................... 8-16
Tune Plus window showing the Display Graph view for manual tuning of the Reagent Ion Source .................................................... 8-17
Reagent Ion Optics dialog box ............................................................ 8-18
Activating Reagent Ion Isolation .......................................................... 8-19
Semi-automatic tune of the Back Multipole Offset dc voltage .......... 8-20
Calibrating the Reagent Ion Selection ................................................... 8-21
Dependence of the signal from the DC Offset ..................................... 8-22
Chosen DC Offset (10 V) is too low for calibration ......................... 8-22
Point of optimum performance .......................................................... 8-23
Chosen DC Offset (32 V) is too high for calibration ......................... 8-23
“Noding” in quadrupoles .................................................................. 8-24
Injection Control dialog box – Reagent page ...................................... 8-25
Tune plus window showing a mass scan of infused
Angiotensin I ...................................................................................... 8-27
Define Scan window with the Activation Type ETD ......................... 8-28
ETD MS/MS spectrum of Angiotensin I .......................................... 8-29
Tune and Define Scan windows open in Tune Plus ......................... 8-30
Tune window showing Product Ion Mass selected for Reagent Ion
Reaction Time Optimization ............................................................. 8-31
Xcalibur Roadmap Home Page .......................................................... 8-33
New Method view in Xcalibur Instrument Setup ......................... 8-34
Xcalibur MS Detector Setup view ....................................................... 8-35
Xcalibur Instrument Setup ................................................................. 8-36
Data Dependent Settings dialog box in MS Detector Setup ............. 8-37
Save As window in Xcalibur Instrument Setup, MS Detector
Setup view ......................................................................................... 8-38
Tables

Available calibration solution packages ................................................. 3-4
Exact masses of calibration compounds (ProteoMass™ MALDI Calibration Kit; Sigma-Aldrich MS-CAL4) ............................................. 7-9
Actual settings of manual toggles .......................................................... A-2
Typical data sizes (per scan) of an FT spectrum ...................................... A-4
Chapter 1 Introduction

This manual describes only the FTMS detector relevant settings and procedures of the LTQ Orbitrap XL software (Tune Plus version 2.5.5). For ion trap relevant settings and procedures, refer to the LTQ XL Getting Started manual.

In addition to this manual, the LTQ Orbitrap XL Tune Plus Online Help gives information to specific topics. Nevertheless, it is recommended to read this manual entirely.
Chapter 2  Tune Plus Window

This chapter provides LTQ Orbitrap XL specific information about the Tune Plus window. It contains the following topics:

- “Preliminary Remarks” on page 2-2
- “View Menu” on page 2-3
- “Scan Mode Menu” on page 2-9
- “Display Menu” on page 2-17
- “Setup Menu” on page 2-18
- “Tune Methods” on page 2-23
Preliminary Remarks

The Tune Plus window shows the schematic view of the LTQ Orbitrap XL and the instrument name. See Figure 2-1.

Figure 2-1. Tune Plus window

To access the functions of the Tune Plus window, use the menu commands, toolbar buttons, and display views. The FT relevant changes or additions of the menu commands, toolbar buttons, and display views are explained in the following chapters.
View Menu

This section describes those elements of the View menu that are different from the LTQ XL version of the Tune Plus window.

Spectrum View

The Spectrum view displays real-time ion trap or FT mass spectra depending on the analyzer type selected in the Define Scan dialog box. See Figure 2-2.

The Spectrum view page has a shortcut menu, which is displayed when you right-click anywhere on the page. To open the Spectrum Display Options dialog box, choose Display Options. The dialog box has two pages: the Ion Trap page and the FT page.
On the FT page, you can determine the number of decimals shown on peak labels. See Figure 2-3. To change the number of decimals, click on the arrows in the spin box to increment [up arrow] or decrement [down arrow] the value. You can set the number of decimals to any value from 0 to 5. Alternatively, you can enter a value in the spin box text field. The LTQ Orbitrap XL changes the number of decimals when you click on Apply or OK.

A check box allows you to show additional analyzer information for FTMS scans. This information will be displayed above the spectrum graph if the box is selected. See topic “FT Analyzer Messages” on page A-3 for a list of items that may be displayed as analyzer information.

You can also decide whether or not to show the resolution and/or the charge state of peaks in the FT spectrum by clearing or selecting the corresponding check boxes.

If the FTMS analyzer is used, it is possible to display different diagnostic views in the Spectrum view. See Chapter 4: “Performing Diagnostics/Checks” for diagnostic features that involve the Spectrum view.
Graph View

The Graph view displays, in a variety of traces, real-time data generated during calibration, tuning, and diagnostic tests. For example, Figure 2-4 shows the progress of the calibration function.

![Graph view page](image)

**Figure 2-4.** Graph view page

Status View

The Status view displays real-time status information for the LTQ Orbitrap XL. See Figure 2-5 on page 2-6. The Status view has two pages: the All page and the User page. The All page displays the real-time status information for about 80 parameters of the LTQ Orbitrap XL. You can scroll through the list to observe the status of the parameters. The User page displays real-time status information for LTQ Orbitrap XL parameters that you have selected in the User Status Display Configuration dialog box. (See page 2-6.)
User Status Display Configuration Dialog Box

Figure 2-6 on page 2-7 shows the User Status Display Configuration dialog box.

❖ To configure the User page

1. Choose View > Display Status View.

2. Click on the User tab. Right-click on the User page to display the shortcut menu.

3. Choose Configure.
Figure 2-6. User Status Display Configuration dialog box
Control Menu

This section describes the elements of the Control menu that are different from the LTQ XL.

Advanced Calibration Features

Use the Advanced Calibration Features command to display advanced features on the Semi-Automatic page of the Calibrate dialog box, such as storage transmission and the FT transmission (See Figure 3-6 on page 3-17):

- If the command is displayed as “Advanced Calibration Features” this indicates that the command is disabled. Normal features will be displayed.

- If the command is displayed as “✓ Advanced Calibration Features” this indicates that the command is enabled. Advanced features will be displayed.

Activate/deactivate this command by choosing Control > Advanced Calibration Features.
Scan Mode Menu

This section describes the elements of the Scan Mode menu that are different from the LTQ XL.

Define Scan

The Define Scan dialog box allows you to define a scan in various ways depending on the scan mode and scan type combination. Also, the Define Scan dialog box allows you to choose the ion trap or the Orbitrap analyzer (FTMS) as analyzer. Figure 2-7 shows the Define Scan dialog box showing the Advanced Scan features. The Advanced Scan features can be activated in the Scan Mode menu of Tune plus.

![Define Scan dialog box (Advanced Scan Features enabled)](image)

Figure 2-7. Define Scan dialog box (Advanced Scan Features enabled)
Scan Description

The Scan Description group box contains the following elements:

**Analyzer**

At the top, the Analyzer list box allows you to select the analyzer type used during the currently selected scan event. The options are as follows:

- **FTMS** selects the Orbitrap detector.
- **Ion Trap** selects the ion trap detector.

**Mass Range**

The following mass ranges are available:

- **Low**: 15–200 for ion trap analyzer only
- **Normal**: 50–2000 for ion trap and FTMS analyzer
- **High**: 100–4000 for ion trap and FTMS analyzer

**Scan Rate / Resolution**

When you have selected the entry Ion Trap in the Analyzer list box, this list box allows you to set the scan rate (Normal, Enhanced, Turbo, Zoom, UltraZoom).

When you have selected the entry FTMS in the Analyzer list box, this list box allows you to set the resolution of the FT mass spectra. The mass resolution is selectable between several options. Available resolution settings are 7500, 15000, 30000, 60000, and 100000.

**Scan Type**

Usage of the scan types Full MS, SIM, SRM, or CRM is analogous to the ion trap. However, only one scan range is available for FTMS SIM, FTMS SRM, and FTMS CRM scans.
**Scan Time**

The Scan Time group box contains the following elements:

**Microscans**

The number of microscans determines how many spectra are averaged in one analytical scan. If the FTMS is chosen as the analyzer, transients are averaged for one analytical scan.

The number of microscans can be set individually for FTMS, Ion Trap MS, FTMS SIM, Ion Trap SIM, FT MS^n, Ion Trap MS^n, and Ion Trap Zoom.

**Max Inject Time**

The inject time is automatically controlled by the automatic gain control (AGC). The entry in this spin box limits the inject time to a maximum value. To ensure the high mass accuracy of the LTQ Orbitrap XL, the maximum inject time should not be reached. Otherwise, the number of ions does not correspond to the AGC target value.

The maximum inject time can be set individually for FTMS, Ion Trap MS, FTMS SIM, Ion Trap SIM, FT MS^n, Ion Trap MS^n, and Ion Trap Zoom.

**Note**

If the maximum inject time is reached the number of ions may not correspond to the current AGC target value. This may affect the mass accuracy of FTMS spectra. ▲

**Scan Time Settings**

Click on **All** to display the Scan Time Settings dialog box. See Figure 2-8. It allows displaying and setting all scan time settings for all scan types at the same time for both the ion trap and the FT analyzer.
Locking

The locking feature allows using one or more peaks in the spectrum as internal reference in order to improve mass accuracy. Locking is available for FTMS analyzer type.

Select the On check box in the Locking group box to enable the locking feature. Then, click on **Masses** to display a dialog box for entering and editing lock mass lists. See Figure 2-9 on page 2-13.

Lock mass lists can consist of one or more lock masses. If the list contains lock masses that are (temporarily) not found in the spectrum, these lock masses are ignored (temporarily) and the instrument steps back to the external calibration. Thus, even when lock masses are used, the instrument should be external calibrated as well. For standard full scan experiments, it is expected that the spectrum shows at least one peak that corresponds to a lock mass.

---

**Figure 2-8.** Scan Time Settings dialog box – FT page
There are two situations where the instrument makes use of a special mode to artificially mix the lock mass into the spectrum:

- If none of the given lock masses is found in the full spectrum, the instrument tries to improve the abundance of the lock mass by performing additional SIM injections of the specified lock mass.
- If the given lock mass cannot be found in the spectrum because the instrument runs in MS^n or SIM scan type, the instrument adds the lock mass by using SIM injections.

This way, lock masses can be used for all FTMS scan types and for varying lock mass abundances. There is no need for user interaction other than specifying a list of reference peak candidates.

See topic “FT Analyzer Messages” on page A-3 on how to view information about the instrument’s locking state. See topic “Using Locking in Automated Runs” on page 5-2 on how to set FTMS locking in Instrument Setup.
MSn Settings

The table in this group box allows you to specify the parameters for each segment of an MSn experiment.

**Act. Type**

The Activation Type list box becomes available when you enter a parent mass. It allows you to specify how the ions are activated for fragmentation and has the following options:

- CID (Collision-induced dissociation)
- PQD (Pulsed-Q dissociation)
- HCD (higher energy CID)

Use HCD to obtain triple quadrupole-like fragment ion spectra. HCD is available only as the last step in an MS^n experiment – it is not possible to set up an experiment where the first activation method is HCD, and the second method is CID. If you enter a new step below an HCD experiment, the Tune Plus program will change it to a CID experiment.

**Act. Q**

When HCD is selected in the Activation Type list box, the Activation Q input box is disabled. For HCD activation, no Q value is used for calculating voltages or amplitudes.

**HCD Charge State**

The required absolute collision energy for fragmentation of given ions depends on their charge states. The collision energy is the lower the higher the charge state is. The algorithm for calculating the absolute collision energy is based on empirical data taken from measurements on peptides. For example, the required absolute energy to fragment [M+2H]^2+ ions is about 75% of that of the corresponding [M+H]^+ ions. For a [M+3H]^3+ ion, the value goes down to 60%.

To take advantage of this, enter the charge state of the ions to be fragmented into the input box. To change the displayed value, click on the arrows in the spin box to increment [up arrow] or decrement [down arrow] the value. Alternatively, you can enter a value in the spin box text field. You can set the HCD charge state to any value from 1 to 99. The default value is 1.
The HCD Charge State spin box is available only if HCD is selected as activation type, regardless of the status of the Advanced Scan features. See Figure 2-10.

**Figure 2-10.** Define Scan dialog box with HCD selected as activation type

### Scan Ranges

When HCD is selected as the activation method in the MSn Settings group box, the First Mass ($m/z$) is set to either $0.05 \times $LastMass or 50, whichever is higher.

### Centroid/Profile

With this pair of buttons, you switch between the centroid and the profile format. The profile format for FTMS data is a compressed profile format. Topic “FT Profile Mode” on page 4-8 describes how to switch to full profile format for FTMS data for diagnostic purposes.

For further information, see also topic “Data Size of FT Raw Files” on page A-4.
Positive/Negative

With this pair of buttons, you can toggle between positive ion and negative ion polarity. Different FT transfer, storage, and mass calibration parameters are used for the different polarities.
Display Menu

This section describes the elements of the Display menu that are different from the LTQ XL.

Spectrum Averaging

With this toggle, spectrum averaging can be switched on or off. If spectrum averaging is enabled the displayed spectrum is the moving average of several spectra before. Averaging FTMS scans is actually an averaging of transients.

Use this functionality in analogy to ion trap scans:

1. In the Tune Plus window, choose Display > Spectrum Averaging > Settings… to display the Spectrum Averaging dialog box. See Figure 2-11.

2. Enter the number of transients to average into the spin box.

3. Click on OK to save your changes and close the dialog box.

Figure 2-11. Spectrum Averaging dialog box
Setup Menu

This section describes the elements of the Setup menu that are different from the LTQ XL.

FT Transfer Optics

The FT transfer parameters are only changed by an FT transmission calibration, which is usually only necessary when the hardware of the system has been modified. This dialog box displays the actual FT readback values for the current scan mode. See Figure 2-12.

Figure 2-12. FT Transfer Optics dialog box

❖ To open this dialog box

• From the Tune Plus window, choose Setup > FT Ion Optics, or

• click on in the Instrument Control toolbar.
FT Injection Control

The Injection Control dialog box allows you to set the automatic gain control (AGC) target values. In addition, the Injection Control dialog box allows you to enable or disable the injection waveforms.

❖ To open this dialog box

- From the Tune Plus window, choose Setup > FT Injection Control, or

- click on in the Instrument Control toolbar.

The Injection Control dialog box has two pages to enable an independent selection of target values for ion trap scans and FT scans.

Ion Trap Page

Recommended target values for the ion trap:

- **Full MS Target:** $3 \times 10^4$
- **SIM Target:** $1 \times 10^4$
- **MS$^n$ Target:** $1 \times 10^4$
- **Zoom Target:** 3000

![Injection Control Dialog Box](image)

**Figure 2-13.** Ion Trap page of the Injection Control dialog box
FT Page

For FTMS measurements, only the Full MS target, the SIM target, and the MS\textsuperscript{n} target are used.

Recommended target values for the FT analyzer:

- **Full MS Target:** \(5 \times 10^5\)
- **SIM Target:** \(5 \times 10^4\)
- **MS\textsuperscript{n} Target:** \(2 \times 10^5\)

**Note** Lower target values than those listed above may be used to obtain shorter inject times. For MS\textsuperscript{n} scans, lower target values may also improve the isolation/fragmentation efficiency. Higher target values than those listed above can be used to improve the dynamic range. However, target values far above the recommended settings may affect isolation/fragmentation efficiency and mass accuracy for the FTMS analyzer. 

![Injection Control dialog box]

**Figure 2-14.** FT page of the Injection Control dialog box

**Enable Full Scan Injection Waveforms**

You can enable or disable the injection waveforms independently for ion trap and FT scans.

If the injection waveforms are enabled, a filter is applied on the ions that are injected into the ion trap. The ions above and below the selected ion or ion range selected are rejected. This option is often useful if the ion trap is being filled with ions of greater or lesser mass than the ion mass or ion mass range of interest. For example, this option can be used to remove high mass ions that are not of interest and to ensure that more target ions can enter the trap before the trap is full.
**Note** The FT injection waveforms option only applies to full scan MS scans performed with the Orbitrap mass analyzer. In FT SIM and FT MS\textsuperscript{3} scans, the injection waveforms are automatically enabled.

## FT Vacuum

The Vacuum dialog box allows you to monitor the vacuum system parameters. The Vacuum dialog box has two pages to enable an independent selection of displaying the vacuum data of the ion trap or the FT part.

![Ion Trap page of the Vacuum dialog box](image1)

**Figure 2-15.** Ion Trap page of the Vacuum dialog box

![FT page of the Vacuum dialog box](image2)

**Figure 2-16.** FT page of the Vacuum dialog box

- To open this dialog box
  - From the Tune Plus window, choose Setup > Vacuum…, or
  - click on in the Instrument Control toolbar.
**FT Temperature Monitor**

The FT Temperature Monitor dialog box allows to view the status of the FTMS analyzer temperature regulation. Deviations of the actual temperature from the temperature setpoint can affect instrument performance. It is not possible to operate the instrument when the bakeout procedure is active.

![FT Temperature Monitor dialog box](image)

*Figure 2-17. FT Temperature Monitor dialog box*

- **To open this dialog box**
  - From the Tune Plus window, choose **Setup > FT Temperature Monitor**…, or
  - click on ![icon](image) in the Instrument Control toolbar.

**FT Lock Masses**

Choose **Setup > FT Lock Masses** to display the Lock Masses dialog box. See *Figure 2-9 on page 2-13*. This dialog box allows entering and editing lock mass lists for positive and negative ion mode. See topic “Locking” on *page 2-12* for details.
Tune Methods

Several parameters, like the ion source parameters, ion trap optics parameters, or AGC target values are stored in tune methods. This topic points out for which parameters a differentiation between ion trap and FTMS is made. The Tune Plus title bar displays the name of the current tune method. If you are not currently editing a preexisting tune method, the title bar displays the word *Untitled*.

Parameters with Differentiation between Ion Trap and FT Scans

A differentiation between ion trap scans and FTMS scans is made for the following tune parameters.

AGC Target Values

They can be set and saved independently for these experimental modes (no differentiation between positive and negative ion polarity mode):

- Ion Trap Full MS Target
- Ion Trap SIM Target
- Ion Trap MS^n Target
- Ion Trap Zoom Target
- FT Full MS Target
- FT SIM Target
- FT MS^n Target

Microscans and Maximum Inject Time

They can be set and saved independently for these experimental modes:

- Ion Trap Full MS, positive ion mode
- Ion Trap SIM, positive ion mode
- Ion Trap MS^n, positive ion mode
- Ion Trap Zoom, positive ion mode
- FT Full MS, positive ion mode
- FT SIM, positive ion mode
- FT MS^n, positive ion mode
- Ion Trap Full MS, negative ion mode
• Ion Trap SIM, negative ion mode
• Ion Trap MS^n, negative ion mode
• Ion Trap Zoom, negative ion mode
• FT Full MS, negative ion mode
• FT SIM, negative ion mode
• FT MS^n, negative ion mode

Inject Waveform Flags

The flag whether the inject waveform is enabled or disabled can be set and saved independently for
• Ion trap scans
• FT full scans.

Parameters without Differentiation between Ion Trap and FT Scans

No differentiation between ion trap scans and FT scans is made for all ESI parameters, and for all ion source and ion optics parameters.

Parameters not saved in a Tune Method

All parameters that can be set in an instrument method are not saved in the tune method. Thus, the following parameters are not saved in a tune method:
• Analyzer (Ion Trap or FTMS)
• Mass Range (Low, Normal, or High)
• Scan Rate
• Resolution
• Scan Type (Full, SIM, SRM, CRM)
• Scan Range
• Polarity* (positive or negative)
• Data type* (centroid or profile)

* Only the data format (centroid or profile) and the ion polarity are saved in a tune file that are set after a new start of Tune Plus.
Chapter 3 Calibrating the Instrument for FTMS Measurements

This chapter provides procedures to calibrate your LTQ Orbitrap XL for FTMS measurements. It contains the following topics:

- “Preliminary Remarks” on page 3-2
- “Calibration Files and their Backups” on page 3-3
- “Calibration Solutions” on page 3-4
- “Calibration and Tuning of the Ion Trap” on page 3-9
- “Automatic Calibration Page” on page 3-13
- “Semi-Automatic Calibration Page” on page 3-15
- “Check Calibration Page” on page 3-18
- “FT Manual Calibration Page” on page 3-21
Preliminary Remarks

There are no specific tune procedures for the FTMS part. All FTMS ion transfer and excitation parameters are treated as calibration parameters and are determined in automatic calibration procedures.

In the automatic calibration, the FT transmission calibration and the FT mass calibration are automatically performed for all calibration ranges. In the semi-automatic calibration, it is possible to decide whether the transmission and/or mass calibration are performed only for the positive ion mode, only for the negative ion mode or for both polarities. See topics “Automatic Calibration Page” on page 3-13 and “Semi-Automatic Calibration Page” on page 3-15 for further details.


Note It is recommended to use the semi-automatic calibration.
Calibration Files and their Backups

After a successful or partly successful calibration, the ion trap and FT calibration parameters are saved automatically. All ion trap and FT calibration parameters are stored in the calibration file master.LTQCal, which is located in the folder:

C:\Thermo\Instruments\LTQ\system\msx

Backup Current Calibration

It is possible to create a backup of the current calibration file manually or by choosing File > Backup Current Calibration in the Tune Plus window. The Backup Current Calibration and Restore Backup Calibration items work by copying the master.LTQCal to user.LTQCal and vice versa.

If a backup calibration user.LTQCal was already generated, the old user.LTQCal will be backed-up to a file named userXYZ.LTQCal. If you perform backup calibrations at regular intervals, then a history of your calibration files is generated in the folder:

C:\Thermo\Instruments\LTQ\system\msx

Using the Backup Calibration command regularly allows to return to previous calibrations in case a new calibration is suspected to worsen instrument performance.

Restore Backup Calibration

Upon Restore Backup Calibration, the calibration values saved in user.LTQCal are automatically downloaded to the instrument. Therefore, it is recommended to generate a current backup after a successful calibration.

It is also recommended to use the Restore Backup Calibration command instead of the Restore Factory Calibration command because the backup calibration file is newer than the factory calibration file.
Calibration Solutions

This section provides information about preparing the calibration solutions for the LTQ Orbitrap XL.

The **positive ion mode calibration solution** allows calibrating Thermo Scientific MS detectors with ESI source in positive ion mode. Supported instruments are the LTQ Orbitrap XL, other LTQ based hybrid instruments (LTQ FT, LTQ FT Ultra, and LTQ Orbitrap series), and the Exactive. The positive ion mode calibration solution covers a mass range from \( m/z \) 138 to \( m/z \) 1822 and is therefore usable for calibrations between \( m/z \) 50 and \( m/z \) 2000.

The **negative ion mode calibration solution** allows calibrating Thermo Scientific MS detectors with ESI source in negative ion mode. Supported instruments are the LTQ Orbitrap XL, other LTQ based hybrid instruments (LTQ FT, LTQ FT Ultra, and LTQ Orbitrap series), and the Exactive. The negative ion mode calibration solution covers a mass range from \( m/z \) 265 to \( m/z \) 1880 and is therefore usable for calibrations between \( m/z \) 50 and \( m/z \) 2000.

Obtaining Ready-to-Use Calibration Solutions

To free you from time-consuming mixing and dilution steps and to allow you to focus on data acquisition, Thermo Fisher Scientific has arranged with Sigma-Aldrich® that you can order ready-to-use calibration solutions from their website (www.sigma-aldrich.com). Table 3-1 shows the available calibration solution packages. 1 EA is a 10 mL Teflon® bottle.

Table 3-1. Available calibration solution packages

<table>
<thead>
<tr>
<th>Calibration Solution</th>
<th>Designation</th>
<th>Product Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive ion mode</td>
<td>ProteoMass™ LTQ/FT-Hybrid ESI Pos. Mode CalMix</td>
<td>MSCALS-1EA (1 EA) MSCALS-10EA (10 EA)</td>
</tr>
<tr>
<td>Negative ion mode</td>
<td>ProteoMass™ LTQ/FT-Hybrid ESI Neg. Mode CalMix</td>
<td>MSCALS-1EA (1 EA) MSCALS-10EA (10 EA)</td>
</tr>
</tbody>
</table>

**Note** If you have not ordered from Sigma-Aldrich in the past, fill out an on-line My Profile form on the Sigma-Aldrich web site (www.sigma-aldrich.com) to request access to the site.

**Caution** The prepared calibration solutions are light and temperature sensitive. They are shipped under dry ice. Store them in darkness and at \(-20 \, ^\circ C \quad (-4 \, ^\circ F)\).
Calibrating the Instrument for FTMS Measurements

Calibration Solutions

LTQ/FT-Hybrid Positive Ion Mode Calibration Solution

The LTQ/FT-hybrid positive ion mode calibration solution consists of caffeine, MRFA, and Ultramark 1621 in an acetonitrile:methanol:water solution containing 1% acetic acid.

**Note** Vials of caffeine, MRFA, and Ultramark 1621 are included in the API accessory kit. To order more of these compounds, contact:

Sigma Chemical Company
P. O. Box 14508
St. Louis, Missouri, USA 63178-9916
Phone (800) 325-3010 (in the USA or Canada)
(314) 771-3750 (outside the USA or Canada)

Web site  [www.sigma-aldrich.com](http://www.sigma-aldrich.com)

**Caution** Avoid exposure to potentially harmful materials. Always wear protective gloves and safety glasses when you handle solvents or corrosives. Also contain waste streams and use proper ventilation. Refer to your supplier's Material Safety Data Sheet (MSDS) for proper handling of a particular solvent.

❖ To prepare the positive ion mode calibration solution

1. Stock Solution: MRFA

Prepare a 1.5 mL stock solution of 166.7 pmol/μL MRFA in 50:50 methanol:water as follows:

a. Obtain the vial of L-methionyl-arginyl-phenylalanyl-alanine acetate × H₂O (MRFA) in your accessory kit. In this form, the MRFA sample has an average molecular weight of 607.7 u. Carefully weigh 3.0 mg of the MRFA sample.

b. Dissolve the MRFA sample in a total volume of 1.0 mL of 50:50 methanol:water. Mix the solution (5.0 nmol/μL) thoroughly.

c. Transfer 50 μL of the 5 nmol/μL solution into a clean polypropylene tube.

d. Add 1.45 mL of 50:50 methanol:water to the tube. Mix this solution (166.7 pmol/μL) thoroughly.

e. Label the tube *MRFA stock solution* and store it in a freezer until it is needed.
2. Ultramark 1621 stock solution

Prepare a 10 mL stock solution of 0.1% Ultramark 1621 in acetonitrile as follows:

a. Obtain the vial of Ultramark 1621 in your accessory kit.

b. Using a syringe, measure out 10 μL of Ultramark 1621, and dissolve it in 10 mL of acetonitrile. Mix the solution thoroughly.

c. Label the vial *Ultramark 1621 stock solution* and store it in a freezer until it is needed.

3. Positive ion mode calibration solution

Prepare 10 mL of the positive ion mode calibration solution as follows:

a. Obtain the 1 mg/mL stock solution of caffeine in 100% methanol that is provided in your accessory kit.

b. Pipet 200 μL of the caffeine stock solution into a light-protected, clean, dry 10 mL volumetric flask.

c. Pipet 100 μL of the MRFA stock solution into the flask.

d. Pipet 100 μL of the Ultramark 1621 stock solution into the flask.

e. Pipet 100 μL of glacial acetic acid into the flask.

f. Pipet 5 mL of acetonitrile into the flask.

g. Bring the volume of the solution up to the 10 mL-mark on the flask with 50:50 methanol:water.

h. Mix the calibration solution thoroughly.

i. Optional: Transfer the solution to a light-protected, clean, dry vial.

j. Label the flask/vial *Positive Ion Mode Calibration Solution* and store it in a freezer until it is needed.

**Note** Using plastic pipet tips causes contamination of acid stock solutions that can introduce contaminants into the calibration solution. ▲
LTQ/FT-Hybrid Negative Ion Mode Calibration Solution

The LTQ/FT-hybrid negative ion mode calibration solution consists of sodium dodecyl sulfate, sodium taurocholate, and Ultramark 1621 in an acetonitrile:methanol:water solution containing 1% acetic acid.

**Note** Vials of sodium dodecyl sulfate and sodium taurocholate are shipped with the instrument. Refer to the Material Safety Data Sheet (MSDS) for proper handling of these substances. To order more of these compounds, contact Sigma-Aldrich. See page 3-5.

**Caution** Avoid exposure to potentially harmful materials. Always wear protective gloves and safety glasses when you handle solvents or corrosives. Also contain waste streams and use proper ventilation. Refer to your supplier’s Material Safety Data Sheet (MSDS) for proper handling of a particular solvent.

❖ To prepare the negative ion mode calibration solution

1. Stock Solution: Sodium Dodecyl Sulfate
   a. Obtain the vial of sodium dodecyl sulfate. In this form, the sample has an average molecular weight of 288.4 u.
   b. Prepare the stock solution of sodium dodecyl sulfate by dissolving 2.88 mg in 10 mL of 50:50 methanol:water.
   c. Mix the solution (1.0 nmol/μL) thoroughly.
   d. Label the vial *Sodium Dodecyl Sulfate stock solution (1 nmol/μL)*.

2. Stock Solution: Sodium Taurocholate
   a. Obtain the vial of sodium taurocholate. In this form, the sample has an average molecular weight of 537.7 u.
   b. Prepare the stock solution of sodium taurocholate by dissolving 5.38 mg in 10 mL of 50:50 methanol:water.
   c. Mix the solution (1.0 nmol/μL) thoroughly.
   d. Label the vial *Sodium Taurocholate stock solution (1 nmol/μL)*.

3. Stock Solution: Ultramark 1621
   To prepare the Ultramark 1621 stock solution (0.1% Ultramark 1621 in acetonitrile), refer to step 2 of topic "LTQ/FT-Hybrid Positive Ion Mode Calibration Solution" above.
4. Negative Ion Mode Calibration Solution

Prepare 10 mL of the negative ion mode calibration solution, as follows:

a. Pipet 100 μL of the Sodium Dodecyl Sulfate stock solution into a light-protected, clean, dry 10 mL volumetric flask.

b. Pipet 100 μL of the Sodium Taurocholate stock solution into the flask.

c. Pipet 100 μL of the Ultramark 1621 stock solution into the flask.

d. Pipet 100 μL of glacial acetic acid into the flask.

Note Using plastic pipet tips causes contamination of acid stock solutions that can introduce contaminants into the calibration solution.

- Pipet 5 mL of acetonitrile into the flask.

- Bring the volume of the solution up to the 10 mL-mark on the flask with 50:50 methanol:water.

- Mix the solution thoroughly.

- Optional: Transfer the solution to a light-protected, clean, dry vial.

- Label the flask/vial Negative Ion Mode Calibration Solution and store it in a freezer until it is needed.

Applicable Calibration Solutions for FT Manual Calibration

Because the FT Manual page of the Calibrate dialog box allows using your own calibration masses, it is possible to use custom calibration solution here. However, there are some requirements for the calibration masses. The scan ranges of the instrument need to be covered properly by the given masses.
Calibration and Tuning of the Ion Trap

This chapter describes the calibration and tuning of the ion trap for FT measurements.

**Calibration of the Ion Trap**

To perform an FT calibration, the ion trap has to be successfully calibrated before. It is very important that the electron multiplier gain is correctly calibrated because the AGC prescan is performed in the ion trap. Thus, the electron multiplier gain calibration should be checked before an FT calibration is performed.

**Note** It is not necessary to use the positive ion mode calibration solution to perform a multiplier gain calibration. It is sufficient to use an MRFA solution (for example 5×10⁻⁶ M in 100% methanol, 1% acetic acid).

For the ion trap calibrations, the positive ion mode calibration solution or the negative ion mode calibration solution can be used.

**Tuning the Ion Trap for Positive Ion Mode**

For the positive ion mode, it is recommended to perform an automatic tune of \textit{m/z} 524 at a Full MS Target of 1e4–3e4. Use the positive ion mode calibration solution or the negative ion mode calibration solution with the following settings in the Define Scan dialog box. See Figure 3-1 on page 3-10.

After the automatic tune, a manual adjustment of the tube lens should be used to get an ion trap spectrum in the scan range \textit{m/z} 130–2000.

The spectrum should look similar to the spectrum shown in Figure 3-2 on page 3-11. Make sure the peaks at \textit{m/z} 138, 195, 524, and the highest Ultramark peaks are all present, ideally above 30% of the base peak.

**Note** The peak at \textit{m/z} 138 should have a height of more than 10%. Run an automatic ion trap tune on \textit{m/z} 138 if this signal is too weak.

The inject time should be stable and less than 1 ms (if a Full MS target of 1e4 is used). Do not forget to save the tune method after a successful tuning.
Figure 3-1. Recommended settings in the Define Scan dialog box for an automatic tune of the ion trap
Tuning the Ion Trap for Negative Ion Mode

For the negative ion mode, it is recommended to perform an automatic tune of $m/z$ 514 at a Full MS Target of 1e4–3e4. Use the negative ion mode calibration solution with the settings shown in Figure 3-1 on page 3-10.

After the automatic tune, a manual adjustment of the tube lens should be used to get an ion trap spectrum in the scan range $m/z$ 150–2000. At $m/z$ 265 is the base peak (100%) and the highest Ultramark adduct ion peaks are at about 80%, as shown in Figure 3-3 on page 3-12.

If the tube lens is set to a very high negative voltage, in-source fragmentation of the Ultramark adduct ions may occur. Thus, if you observe rather ions at $m/z$ 906, 1006, … than ions at $m/z$ 1280, 1380, … the tube lens setting has to be decreased. The inject time should be stable and less than 1 ms (if a target of 1e4 is used). Do not forget to save the tune method after a successful tuning.
Calibrating the Instrument for FTMS Measurements

Calibration and Tuning of the Ion Trap

Figure 3-3. Ion trap spectrum of the negative ion mode calibration solution, scan range m/z 150–2000, negative ion mode
Automatic Calibration Page

The Automatic page of the Calibrate dialog box (see Figure 3-4) allows you to perform an automatic calibration of all the calibration parameters including all ion trap calibrations and all FT calibrations.

![Automatic Calibration Page](image)

Figure 3-4. Automatic page of the Calibrate dialog box

In an automatic calibration the FT calibration procedures are performed automatically one after another, following the ion trap calibration. To perform an automatic calibration, the negative ion mode calibration solution has to be used.

The calibration masses and all experimental parameters (for example, target values, scan ranges, or resolution settings) are set automatically and cannot be influenced by the user.
**Note** Usually, you do not need to perform a complete ion trap calibration or an FT ion transmission calibration unless the hardware is modified in some way. However, it is necessary to repeat the electron multiplier calibration and the FT mass calibration on a regular basis. Thus, in the most cases it is not recommended to perform an automatic calibration of the LTQ Orbitrap XL. In this case, all calibrations are performed, which takes about 1 hour. To run a multiplier gain calibration or an FT mass calibration (which takes only some minutes), it is recommended to use the semiautomatic calibration.
Semi-Automatic Calibration Page

The Semi-Automatic page of the Calibrate dialog box (see Figure 3-5) allows you to select specific calibration parameters to calibrate, for example only the ion trap calibrations or only the FT calibrations. For FT calibrations, it is also possible to differentiate between positive and negative ion mode.

![Calibrate dialog box](image)

**Figure 3-5.** Semi-Automatic page of the Calibrate dialog box

To calibrate one or more selected parameters, clear the Select All check box to make the individual calibration parameters available. Select the parameter(s) you want to calibrate, then click on **Start**.
For example:

- To run a complete automatic calibration (ion trap and FT), select the Select All check box. Then, click on Start. This is analogous to the automatic calibration. As already described before, it is not recommended to perform an automatic calibration of the LTQ Orbitrap XL if not necessary because all calibrations are performed, which takes about 1 hour.

- To run an automatic calibration of the ion trap, select the Select All – Ion Trap check box. Then, click on Start.

- To run an automatic calibration of the FT part, select the Select All – FT check box. Then, click on Start.

- To run an FT mass calibration, select the Mass Calibration check box. Then, click on Start.

In a semi-automatic calibration, the selected FT calibration procedure(s) are performed automatically one after another.

All calibrations apart from the FT calibrations for the negative ion mode can be performed with either the positive ion mode calibration solution or the negative ion mode calibration solution. To run the FT ion transmission and/or mass calibration for the negative ion mode, the negative ion mode calibration solution has to be used.

The calibration masses and all experimental parameters like target values, scan ranges, resolution settings, inject waveforms etc. are set automatically and cannot be influenced by the user.

**HCD Calibration**

The Semi-Automatic page of the Calibrate dialog box allows calibrating the HCD collision energy and the HCD transmission for the positive and negative ion mode as well.

**Note** Calibrate the HCD transmission before you calibrate the HCD collision energy.

**HCD Collision Energy**

This check box allows you to specify whether or not to calibrate the HCD collision energy. To calibrate the HCD collision energy, first make this check box available by clearing the Select All check box. Then, select the HCD Collision Energy check box.
HCD Transmission

This check box allows you to specify whether or not to calibrate the HCD transmission. To calibrate the HCD transmission, first make this check box available by clearing the Select All check box. Then, select the HCD Transmission check box.

Advanced Calibration Features

When the Advanced Calibration Features in the Control menu are enabled, the Semi-Automatic page of the Calibrate dialog box additionally allows calibrating the storage transmission and the FT transmission for the positive and negative ion mode as well. See Figure 3-6.

Note Do not calibrate the FT transmission and/or the storage transmission unless the respective calibration checks have failed. ▲

Figure 3-6. Semi-Automatic page of the Calibrate dialog box (Advanced Calibration Features enabled)
Calibrating the Instrument for FTMS Measurements
Check Calibration Page

The Check page of the Calibrate dialog box allows you to automatically check several calibration settings. See Figure 3-7.

Figure 3-7. Check page of the Calibrate dialog box

All calibration checks apart from those for the FT negative ion mode can be performed with either the negative ion mode calibration solution or the positive ion mode calibration solution. To check the FT calibrations in the negative ion mode, the negative ion mode calibration solution has to be used.

The calibration masses and all experimental parameters like target values, scan ranges, resolution settings, etc. are set automatically.

At the conclusion of the check procedure, the LTQ XL MS detector displays a message that indicates whether the parameter(s) are calibrated properly or not.
Using the Check page of the Calibrate dialog box, you can select the following parameters:

**Select All**
This check box allows you to specify whether or not to check all of the calibration parameters. To check all calibration parameters, select the Select All check box. In this case, all ion trap calibration parameters and all FT calibration parameters are checked. You can also check each calibration parameter individually. To make the individual calibration parameters available, clear the Select All check box.

**Select All Ion Trap**
This check box allows you to specify whether or not to check the calibration of only the ion trap parameters.

**Select All-FT**
This check box allows you to specify whether or not to check the calibration of only the FT ion transfer optics and mass analyzer.

**Transfer Multipole RF Frequency**
This check box allows you to specify whether or not to check the frequency of the RF voltage of the transfer multipole in the FT transfer ion optics.

**Storage Multipole RF Frequency**
This check box allows you to specify whether or not to check the frequency of the RF voltage of the storage multipole in the FT transfer ion optics.

**Positive Ion Mode**
This check box allows you to specify whether or not to check the FT ion transmission calibration and FT mass calibration for the positive ion mode.

**Negative Ion Mode**
This check box allows you to specify whether or not to check the FT ion transmission calibration and FT mass calibration for the negative ion mode.

**Storage Transmission**
This check box allows you to specify whether or not to check the ion storage transmission calibration. The storage transmission is checked by transferring ions from the ion trap to the ion storage device and backward, then scanning in the ion trap. The FT storage transmission calibration can be checked for the positive and negative ion mode independently.
Calibrating the Instrument for FTMS Measurements
Check Calibration Page

**FT Transmission**
This check box allows you to specify whether or not to check the FT ion transmission calibration. The ion transmission from the ion trap to the Orbitrap is checked by means of the calibration masses in SIM experiments at different AGC target values. The FT transmission calibration can be checked for the positive and negative ion mode independently.

**Mass Calibration**
This check box allows you to specify whether or not to check the mass calibration of the Orbitrap mass analyzer. By doing so, the current mass calibration is checked, i.e. it is a check of the external mass calibration. The FT mass calibration can be checked for the positive and negative ion mode independently.

**HCD Collision Energy**
This check box allows you to specify whether or not to check the HCD collision energy calibration. To check the HCD collision energy calibration, first make this check box available by clearing the Select All check box. Then, select the HCD Collision Energy check box.

**HCD Transmission**
This check box allows you to specify whether or not to check the HCD transmission calibration. To check the HCD transmission calibration, first make this check box available by clearing the Select All check box. Then, select the HCD Transmission check box.

The Last Check Date readback column gives the date of the last successful check for each item. If a check is performed that fails, the last successful check date still appears in the Last Check Date readback column. The last successful check continues to be in effect in the instrument. However, the result column will show a red x mark indicating that the current attempt check has failed or was aborted.
FT Manual Calibration Page

The FT Manual page of the Calibrate dialog box allows to perform or to check an FT transmission calibration, a storage transmission calibration, and an FT mass calibration with user-defined calibration masses. See Figure 3-8.

![FT Manual page of the Calibrate dialog box](image)

**Figure 3-8.** FT Manual page of the Calibrate dialog box

All experimental parameters like target values, scan ranges, resolution settings, etc. must be set manually.

**Note** When starting from the FT Manual page, the calibration is performed for the currently selected polarity only.
Mass List Group Box

The calibration masses for manual calibration can be defined in the corresponding mass list on the FT Manual page of the Calibrate dialog box. Mass lists can be imported and exported by means of the Instrument Configuration page, see further details in Chapter 6: “Instrument Configuration”.

Name  This list box lists the names of the factory supplied and user created mass lists.

Mass List  This table lists the mass-to-charge ratios of the ions that you are using to calibrate the Orbitrap mass analyzer. You can select an existing mass list in the Name list box, or you can create or modify a mass list by clicking on it and editing the entries in the Mass List table.

Note  Ensure that you use calibration masses of sufficient accuracy (sub ppm). ▲

Save  Click on Save to save the mass list with the name that is selected in the Name list box.

Save As  Click on Save As a to save the mass list with a new name.

Delete  Click on Delete to delete the mass list that is selected in the Name list box.

Factory-Supplied Mass Lists

There are also two factory supplied mass lists, calmix_positive (factory) and calmix_negative (factory). They contain the exact masses of all main ion peaks, which should appear if the negative ion mode calibration solution is used in positive or negative ion mode, respectively.
Chapter 4 Performing Diagnostics/Checks

This chapter describes several diagnostic procedures for the LTQ Orbitrap XL. It contains the following topics:

- “System Evaluation Procedures” on page 4-2
- “Toggles” on page 4-6
- “Set Device” on page 4-10
- “Display Settings” on page 4-12
System Evaluation Procedures

The System Evaluation page in the Diagnostics dialog box allows you to evaluate system performance. See Figure 4-1.

Figure 4-1. System evaluation page of the Diagnostics dialog box

Besides several ion trap relevant system evaluation procedures, you can perform various FT system evaluation procedures, which are described in the following topics.

**FT Dynamic Range Test**

This test is only applicable for an infusion experiment with a solution containing MRFA, for example the positive ion mode calibration solution or a MRFA alone solution (for example 5×10^{-6} M in 100% methanol/water, 1% acetic acid). This test determines the signal-to-noise ratio of an isolated MRFA signal.

**FT Energy Dependence Evaluation**

This procedure determines the change in mass calibration when varying the ion energy (HV Offset). This procedure can help evaluating the FTMS analyzer components.
FT HCD Collision Cell Ejection Evaluation

This procedure analyzes the dynamics of ions in the HCD collision cell. This procedure can help evaluating the HCD collision cell components.

FT High Mass Range Target Compensation

This procedure determines an AGC target compensation factor, which ensures that the FT mass calibration is still valid if the instrument is set into the high mass range mode. The resulting compensation factor will be saved in the calibration file. Usually, it is sufficient to run this procedure once. It is not necessary to repeat this procedure on a regular basis. It is recommended to use the positive ion mode calibration solution for this test. However, you can also use any other solution that gives reasonable ion signals at 1000 < m/z < 2000.

FT Isolation Test

This test is only applicable for an infusion experiment with a solution containing MRFA, for example the positive ion mode calibration solution or a MRFA alone solution (for example 5×10^{-6} M in 100% methanol/water, 1% acetic acid). This test is analogous to the “Check of the ion isolation waveform” on the Check page of the Calibrate dialog box. Here, the isolation of m/z 525.3 is performed at a target of 2000 and analyzed by the ion trap. In contrast to this, the FT isolation test is performed at higher targets and uses the FT analyzer. Thus this test determines the maximum AGC target value that allows performing a unit isolation of m/z 525.3 at the presence of m/z 524.3 and 526.3.

FT Noise Test

This test determines resistant noise peaks in the selected scan range. In this test ions are “switched off” automatically. At the conclusion of the FT noise test, a list of resistant noise peaks is displayed in the Testing text.

FT Preamp Evaluation

This evaluation allows checking the basic FTMS analyzer signal detection path. The instrument needs to run in FTMS analyzer mode. It is recommended to switch to diagnostic transient view, see topic “FT Include Transients” on page 4-7.
During the evaluation, the preamplifier input protection switches are activated with a period of 100 ms. This switching can be observed as periodic incidences in the transient if the electronic signal path is operational.

**FT Pulser Evaluation**

This procedure tests characteristics of the high voltage pulser. This procedure can help evaluating the FTMS analyzer electronics.

**FT Sensitivity Test**

The FT sensitivity test is only applicable for an infusion experiment with reserpine. The test assumes that a reserpine solution of $5 \times 10^{-9}$ M (100% methanol, 1% acetic acid) is used. The following test are performed one after another:

1. SIM of $m/z$ 609.28 using the ion trap as analyzer and an AGC target of $2 \times 10^3$.
2. SIM of $m/z$ 609.28 using the Orbitrap detector as analyzer and an AGC target of $5 \times 10^3$.
3. SIM of $m/z$ 609.28 using the Orbitrap detector as analyzer and an AGC target of $5 \times 10^4$.
4. MS/MS of $m/z$ 609.28 using the Orbitrap detector and an AGC target of $5 \times 10^4$.

The test fails

1. if the inject time, which is necessary to reach the selected AGC target value, is too high;
2. if the ratio of the reserpine signal to the overall signal inside the SIM window is too low;
3. if the ion transmission from the ion trap to the Orbitrap detector is too low, or
4. if the intensity of the product ions of reserpine is too low.

**FT Stability Test**

This test is applicable for an infusion experiment with any sample solution. This test procedure checks the stability of the FT TIC (total ion current) detected in the selected scan range by means of 600 scans. In principle, the test can be performed at any experimental conditions. It is recommended, however, to perform this test in Full scan mode.
using one microscan, a resolution setting of 60000 and a FT Full MS Target of 5e+05 or 1e+06. At the conclusion of the FT stability test, the AGC stability and the corresponding signal variation is displayed.

**FT Temperature Control Evaluation**

This evaluation procedure allows examining temperature regulation behavior of the instrument by intentionally driving temperatures to extreme values.

**Note** The evaluation will usually take more than 12 hours where no measurements can be done. After stopping the evaluation, the instrument needs to stabilize temperatures for several hours before high mass accuracy measurements can be started. ▲

**FT Temperature Monitor**

Mass accuracy of the Orbitrap detector with external mass calibration depends on a stable temperature of the analyzer and the electronic components. This evaluation plots a history of the temperature regulation results to the Graph view, see topic “Graph View” on page 2-5.
Performing Diagnostics/Checks

Toggles

The Toggles page in the Diagnostics dialog box allows you to toggle [change] a subsystem from one state to another state. See Figure 4-3.

To display this page

From the Tune Plus window, choose Diagnostics > Diagnostics > Tools > Toggles.

Caution All toggles should only be used for diagnostic purposes. The functionality of the LTQ Orbitrap XL may be harmed if a toggle is switched to a status that differs from its default value.

If one of the FT toggles is (accidentally) different from its default value during data acquisition, the FT Analyzer Settings of the Scan Header of a raw file contains a reference to this. See Appendix A: “Miscellaneous Information” for further details.

Note The status of a toggle is not saved in the tune method and is set back to its default value after an instrument reset. The toggle state shown by the radio buttons next to the list box does not necessarily correspond to the actual settings.
**FT Analyzer Ion Gauge**

With this toggle, the ion gauge for the FT analyzer vacuum can be disabled manually for diagnostic purposes. The default setting is **On** (enabled).

**FT Analyzer Temperature Control**

With this toggle, the FT analyzer temperature control regulation electronics can be disabled for diagnostic purposes. The default setting is **On** (enabled).

**FT Apodization**

With this toggle, the apodization can be switched on or off. The default setting is **On**.

**FT HCD Collision Gas**

With this toggle, the HCD collision gas can be switched on or off. The default setting is **On**. The default setting can be changed in the Instrument Configuration application.

**FT Include Transients**

If this toggle is on, it is possible to display transients in the Spectrum view by choosing **Show FT Transient** in the shortcut menu of the Spectrum view. The menu is displayed when you right-click anywhere on that page. See topic “Spectrum View” on page 2-3 for further details.

**Note** A transient view is only possible if profile (instead of centroid) is chosen as data format. ▲

During transient display in Spectrum view, the x-coordinate is misleadingly labeled with \(m/z\) instead of milliseconds. The default setting is **Off**.

**Note** It is not possible to acquire transients into an Xcalibur raw file. ▲
Performing Diagnostics/Checks
Toggles

FT Manual Calibration for Single Range

This toggle can be used to influence the behavior of the FT manual calibration procedures, refer to topic “FT Manual Calibration Page” on page 3-21. In the default behavior, the FT manual calibration procedures calibrate the whole scan mass range for the actual polarity.

In order to be able to use nonstandard calibration substances that cover a limited mass range only, advanced users may enable this toggle. With this toggle enabled, there is no check for mass range coverage of reference mass lists. Instead, the instrument stays in the chosen mass range and calibrates this range only. With this toggle enabled, the user is responsible to cover the whole mass range needed, possibly by calibrating manually in several steps with different substances. If the performed FT manual calibration is not suitable for the scan settings used in an FTMS analyzer data acquisition, the scan header of a raw data file contains a reference to this. See Chapter A: “Miscellaneous Information” for further details.

FT Profile Mode

With this toggle you can select whether the FT profile mode corresponds to a Full Profile format or to a Reduced Profile format. It is recommended to use the Reduced Profile Mode for data acquisition because the data size of the raw file is significantly decreased by using the Reduced Profile. The default setting is Reduced. For further information, see also topic “Data Size of FT Raw Files” on page A-4.

FT SIM and MS\textsuperscript{n} Injection Waveforms

Usually, for FT SIM scans and FT MS\textsuperscript{n} scans the injection waveforms are automatically enabled. It is not possible to change this setting in the Injection Control dialog box. With this toggle, it is possible to disable or enable the injection waveforms manually for diagnostic purposes. The default setting is On.

FT Storage Evaluation Mode

This toggle can be used to test the characteristics of ion transfer components for the FTMS analyzer. The default setting is On (enabled).
Performing Diagnostics/Checks

Toggles

FT Storage Multipole RF

This toggle can be used to switch the FT storage multipole RF on or off. The default setting is On. If the multipole RF is switched on, the corresponding blue diagnostic LED of the ion optic supply board should be on (indicating that the RF1 generator is switched on). See the LTQ Orbitrap XL Hardware Manual for further details.

FT Transfer Multipole RF

This toggle can be used to switch the FT transfer multipole RF on or off. The default setting is On. If the multipole RF is switched on, the corresponding blue diagnostic LED of the ion optic supply board should be on (indicating that the RF2 generator is switched on). See the LTQ Orbitrap XL Hardware Manual for further details.

FT View Frequency

If this toggle is switched on, the FT spectrum is shown as a frequency spectrum. If the system is on and the FT is chosen as analyzer, the frequency spectrum is displayed in the Spectrum view. The default setting is Off.

Note The x-coordinate is misleadingly labeled with m/z instead of kHz. ▲

This toggle is for diagnostic purposes only. Therefore, it is not possible to acquire frequency spectra.

FT Zero Offset

If this toggle is switched on, an offset is added to the spectrum. This enables to view the full noise band. The default setting is Off, if the Reduced Profile format is used. The setting is On, if the Full Profile format is used.
Set Device

The Set device page of the Diagnostics dialog box allows you to select devices or experimental parameters from the list and to set the value for that device or parameter. See Figure 4-4.

❖ To set a device

1. Select the device or parameter you would like to set from the Device list box.

2. Enter the device parameter's value in the text box below the Device list box.

3. Click on Set to apply the change to the device value or parameter.

![Figure 4-4. Set device page of the Diagnostics dialog box](image)

Note The value in the text box below the Device list box, which is displayed after the call of this page, does not necessarily correspond to the actual value. ▲

There are several FT relevant parameters, which may be changed from this page.
Note After an instrument reset, the manual settings are overwritten with the corresponding calibration parameters.

Caution Changing the instrument settings can harm the functionality of the LTQ Orbitrap XL, especially if followed by saving the calibration parameters (manually or at conclusion of a calibration procedure). Thus, this option should only be used by very advanced users.

FT Lockmass Abundance

This device allows changing the target value of an injected lock mass relative to the actual FT scan target value. The recommended default is 10 percent. Also refer to topic “Locking” on page 2-12.

FT Mass Check Test Duration

This device allows changing the duration of FT Manual mass calibration checks, see topic “FT Manual Calibration Page” on page 3-21. By changing this value, a long-term mass stability evaluation can be run. The default behavior of the FT manual mass calibration check is to perform 100 scans checking the mass accuracy. The test duration may be extended to up to 72 hours. The default behavior can be restored by setting the duration to zero. If the duration is set between two and 24 hours, the FT manual mass calibration check will specially control the syringe pump in order to allow running long-term test with a single syringe filling. For durations above 24 hours, it is assumed that an external syringe pump is used.

Setting new FT Transfer Optics Parameters

There are two set device items that can be used to overwrite the FT optics values:

- FT Optics Device Address
- FT Optics Set Value

These values are originally determined during instrument calibration and set automatically. Overwriting calibration values will influence instrument performance and should only be done for diagnostic purposes.

Note If you have changed FT transfer optics settings, it is recommended to perform a full FT instrument calibration afterwards to assure good instrument performance.
Display Settings

The Display Settings page in the Diagnostics dialog box allows you to select a variety of instrument settings for display. See Figure 4-5. Select the instrument settings you want to display and click Start. The LTQ Orbitrap XL displays the requested instrument settings in the Testing text box.

The following FT relevant instrument settings can be displayed:

- FT calibration settings
- FT diagnostics
- FT instrument settings

Figure 4-5. Display settings page of the Diagnostics dialog box

Display FT Calibration Settings

Displays all FT relevant calibration parameters in the diagnostics text box.

Display FT Diagnostics

Displays current diagnostic readback values of the FT electronic boards.
Display FT Instrument Settings

Displays the current values of those FT instrument settings that depend on the scan range and ion polarity mode and can be changed manually on the Set Device page of the Diagnostics dialog box.
Chapter 5 Instrument Setup

This chapter takes a look at the “Locking” feature in automated runs and describes the FT relevant topics of the data dependent settings in the Instrument Setup. It contains the following topics:

• “Using Locking in Automated Runs” on page 5-2
• “Data Dependent Settings” on page 5-3
Using Locking in Automated Runs

To use locking in an automated run, use the Instrument Setup program.

**Note** Refer to topic “Locking” on page 2-12 for a basic description on using locking with FTMS analyzer scans.

The Lock Mass List button on the right side of the Segment settings group box displays a lock mass list editor dialog. See Figure 2-9 on page 2-13. Segment-related lock masses can be entered here. There are separate lists for positive ion and negative ion mode. If the lock mass for a segment is empty, no locking will be applied in the run and the external mass calibration will be used.

![MS Detector Setup View – MS Detector Setup Page](image)
Data Dependent Settings

This section describes the FT relevant topics of the data dependent settings in the Instrument Setup.

Using Masses instead of Mass-to-Charge Ratios

Figure 5-2 shows the Global page of the Data Dependent Settings dialog box. It allows you to select dependent scan settings that apply to all dependent scans.

Instrument Setup allows using mass units in the input fields of dialog boxes instead of mass-to-charge ratios. To enable this feature, select the check box on the Global page and click OK. From now on, you can enter just the uncharged masses of the most intensive peaks. It is not necessary anymore to consider all possible charge states. LTQ Orbitrap XL determines the charge state from the full scan and converts these masses to mass-to-charge ratios. Enabling this feature affects the parameters in the data dependent settings as described below.
Mass Units in Global Parameters

Global
Mass Range is interpreted as masses. Therefore, a mass range of $m/z$ 500–2000 will allow selecting a M$^{2+}$ peak at $m/z$ 251, but will ignore a M$^{2+}$ peak at $m/z$ 1001.

Mass Widths
Exclusion mass widths are interpreted as masses. Note that the isotope exclusion functionality will be based on masses. Therefore, if both a M$^{2+}$ and M$^{3+}$ peak show up for the same peptide in a full scan, only the more abundant charge state will be selected. Parent mass widths are interpreted as masses. Reject mass widths are interpreted as masses.

Dynamic Exclusion
Dynamic exclusion mass widths are interpreted as masses. When a peak is dynamically excluded, the neutral mass is put on the list. Therefore, other charge states of the same mass will be excluded in future cycles.

Mass Tags
Mass deltas are interpreted as masses. The mass deltas are converted back to mass-to-charge ratios based on the detected charge state of the selected peak. The partner must also have the same charge state. Mass tolerances are based on exclusion mass widths.

Isotopic Data Dependence
Mass differences are interpreted as masses. The mass differences are converted back to mass-to-charge ratios based on the detected charge state of the selected peak.

Neutral Loss
Neutral loss mass widths are interpreted as masses.

Product
Product mass widths are interpreted as masses.
Mass Units in Segment Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parent Mass List</strong></td>
<td>Input will be interpreted as neutral masses – not [M+H]^+ or [M-H]^+. If “MS Charge State” is specified in the mass list, this value is used to convert the mass back to a mass-to-charge ratio. If this is not specified, masses are converted to mass-to-charge ratios based on all charge states that are not on the rejection list. “4 and up” is an allowed charge state, but the search is only performed for 4, and not 5, 6, etc. If more than one charge state is identified, only the most abundant is selected.</td>
</tr>
<tr>
<td><strong>Reject Mass List</strong></td>
<td>Input will be interpreted as neutral masses – not [M+H]^+ or [M-H]^+.</td>
</tr>
<tr>
<td><strong>Charge State</strong></td>
<td>Because masses must be converted back to mass-to-charge ratios, the charge state must be known for any peak that is analyzed. Therefore, rejection of unassigned charge states is automatically enforced.</td>
</tr>
<tr>
<td><strong>Neutral Loss</strong></td>
<td>Masses are interpreted as masses. The charge state used to convert back to mass-to-charge ratio is based on the peak being analyzed. The charge state of the potential partner must match the charge state of the peak.</td>
</tr>
<tr>
<td><strong>Product Mass List</strong></td>
<td>Input will be interpreted as neutral masses – not [M+H]^+ or [M-H]^+.</td>
</tr>
<tr>
<td><strong>Add/Sub</strong></td>
<td>Mass is interpreted as a mass and is converted to mass-to-charge based on the charge state of the selected peak.</td>
</tr>
</tbody>
</table>
Preview Mode

Figure 5-3 shows the Current Segment page of the Data Dependent Settings dialog box.

If the preview mode for FTMS master scans is enabled on the Current Segment page, the data dependent decision is made on the basis of the FT master scan with lower resolution to increase the duty cycle. The resolution of the FTMS scan itself is not changed. Because the high resolution is usually not required to make the data dependent decision, it is recommended to enable the preview mode.

To prevent making data dependent decisions on basis of lower-resolution preview spectra, disable this option. For example, if there are ions with high charge states to be examined, and the data dependent settings require charge state recognition of precursor ions, this might be a reason to turn off this option. Otherwise, the high charge state clusters may not be resolved and charge states will not be recognized in preview mode.
Monoisotopic Precursor Selection

Figure 5-4 shows Charge State page of the Data Dependent Settings dialog box.

If the monoisotopic precursor selection is enabled on the Charge State page, the data dependent scan is only performed for one molecular ion of the corresponding overall $^{13}$C isotopic distribution if Dynamic Exclusion is enabled.

This check box is only available on the Charge State page if the Advanced Features are turned on in the LTQ Orbitrap XL menu of the Instrument Setup.

**Note** The algorithm for isotopic cluster recognition will handle correctly only such isotopic distributions where the third peak ($A + 2$) is lower in intensity than the second peak ($A + 1$). For more complex isotopic patterns (for example, molecules containing Sn, Br, or multiple Cl atoms), it is recommended to clear the Enable monoisotopic precursor selection check box.
Use Non-Peptide Monoisotopic Recognition

This check box is only available if monoisotopic precursor selection is active. If monoisotopic precursor selection is active and this box is not checked, precursor ions in FT master scans must match peptide-type isotopic distribution in order to identify the monoisotopic peak. If this box is selected, monoisotopic peaks will also be identified for small molecules and precursor ions with non-peptide-type isotopic distributions.

Data Dependent FT SIM Scans

A data dependent FT SIM scan is performed around the center mass determined in a previous reference scan event if the check box “Same MS order as referenced scan event” is selected on the Current Scan Event page as shown in Figure 5-5.

![Data Dependent Settings dialog box – Current Scan Event page](image)

Figure 5-5. Data Dependent Settings dialog box – Current Scan Event page

Repeat previous Scan Event with HCD

The Repeat previous scan event with HCD check box will only be available when all of the following requirements are fulfilled:

- FTMS is selected as the mass analyzer for the current scan event.
A neutral loss or product ion list is specified for the referenced scan event.

Either option From neutral loss list or From product list is selected.

HCD is selected as activation type on the Activation page. See page 5-11.

Select the check box to repeat the previous scan event with HCD activation type. A typical experiment to use this feature would be to trigger an HCD fragmentation experiment with a neutral loss observed in an ion trap MS/MS experiment. See Figure 5-6.

![Data Dependent Settings](image)

**Figure 5-6.** Current Scan Event page – Repeat previous scan event with HCD
Scan Width

The scan width of the data dependent FT SIM scan can be selected on the Scan widths page of the Data Dependent Settings dialog box. See Figure 5-7.

**Figure 5-7.** Data Dependent Settings dialog box – Scan Widths page
Activation Type

On the Activation page of the Data Dependent Settings dialog box, the Activation type list box allows you to specify how the ions are activated for fragmentation during a data dependent experiment. See Figure 5-8. It has the following options:

- CID (Collision-induced dissociation)
- PQD (Pulsed-Q dissociation)
- HCD (higher energy CID)

Use HCD to obtain triple quadrupole-like fragment ion spectra. If you select HCD, the Activation Q spin box becomes unavailable.

Figure 5-8. Data Dependent Settings dialog box – Activation page
FT HCD

The FT HCD page of the Data Dependent Settings dialog box will only be available when FTMS is selected as the mass analyzer for the current scan event. See Figure 5-9.

Figure 5-9. Data Dependent Settings dialog box – FT HCD page

The FT HCD page offers you two modes for choosing the first mass of the dependent scan:

- a mass with a fixed m/z value
  
  To change the m/z value, click on the arrows in the spin box to increment [up arrow] or decrement [down arrow] the value. You can set m/z to any value from 50 to 4000; default is 100. Alternatively, you can enter a value in the spin box text field.

- a mass with an m/z value that is relative to the precursor mass.

  To change the percentage, click on the arrows in the spin box to increment [up arrow] or decrement [down arrow] the value. You can set the percentage to any value from 0 to 4; default is 0.25.
  Alternatively, you can enter a value in the spin box text field.
**MSn Settings for HCD Experiments**

Similar to the Define Scan dialog box, the Instrument Setup allows selecting the Activation type (CID/PQD/HCD). See topic “MSn Settings” on page 2-14. Use HCD to obtain triple quadrupole-like fragment ion spectra. If you select HCD as activation type, the HCD charge state input box becomes available and the Activation Q input box is disabled.

![Figure 5-10. MS Detector Setup Page – Scan event settings with HCD experiment](image)
Chapter 6 Instrument Configuration

This chapter gives instructions on how to configure your instrument. It contains the following topics:

• “Starting Instrument Configuration” on page 6-2
• “FT Settings Page” on page 6-3
• “FT Mass Lists Page” on page 6-4
Starting Instrument Configuration

From the Instrument Configuration dialog box, click on the LTQ Orbitrap XL MS button in the Configured Devices group box. See Figure 6-1. Then, click on the Configure button to open the LTQ Orbitrap XL Configuration dialog box.

![Instrument Configuration dialog box](image)

**Figure 6-1.** Instrument Configuration dialog box

The LTQ Orbitrap XL Configuration dialog box allows you to enter LTQ Orbitrap XL configuration information by using several pages, including the FT Settings page and the FT Manual Calibration page.

The elements of the pages are described in the following topics.
FT Settings Page

The FT Settings page of the LTQ Orbitrap XL Configuration dialog box allows you to edit the FTMS analyzer temperature setpoint and to enable the HCD collision gas.

![FT Settings Page](image)

**Figure 6-2.** LTQ Orbitrap XL Configuration dialog box – FT Settings page

Using the FT Settings page of the LTQ Configuration dialog box, you can select the following parameters:

- **Enable HCD collision gas**: Select the check box to enable the HCD collision gas. Otherwise, using HCD fragmentation is not possible. It is recommended to clear this check box only for diagnostic purposes.

- **FTMS analyzer temperature setpoint (°C)**: Enter the desired temperature for the Orbitrap analyzer chamber. The default value is 26.

**Note**  Configuration changes will become effective when you reboot your instrument. ▲
FT Mass Lists Page

The FT Mass Lists page of the LTQ Orbitrap XL Configuration dialog box allows you to manipulate the mass lists that are displayed in the FT Manual Calibration page of the Calibration dialog box. See Figure 6-3. You can also import or export a mass list as a text file.

![Figure 6-3. LTQ Orbitrap XL Configuration dialog box – FT Mass Lists page](image)

Using the FT Mass Lists page of the LTQ Orbitrap XL Configuration dialog box, you can select the following parameters:

**Name**

This list box lists the names of the factory supplied and user created mass lists.

**Mass List**

This table lists the mass-to-charge ratios of the ions that you are using to calibrate the Orbitrap mass analyzer. You can select an existing mass list in the Name list box, or you can create or modify a mass list by clicking on and editing the entries in the Mass List table.

**Note** Ensure that you use calibration masses of sufficient accuracy (sub ppm).

**Save**

Click on **Save** to save the mass list with the name that is selected in the Name list box.

**Save As**

Click on **Save As** to save the mass list with a new name.
Delete  Click on Delete to delete the mass list that is selected in the Name list box.

Import  Click on Import to import a mass list that is a text file.

Export  Click on Export to export a mass list to a text file.

Show Factory Lists  Select this check box if you want to show the factory calibration mass lists in Tune Plus.
Chapter 7 MALDI LTQ Orbitrap Series Instruments

This chapter describes only the Orbitrap relevant differences in instrument settings and procedures with respect to using a MALDI LTQ Orbitrap Series instrument. For further information, refer to the previous chapters of this manual, the MALDI Source Getting Started manual (P/N 97155-97012), and the MALDI Source Hardware Manual (P/N 97155-97013).

This chapter contains the following topics:

- “Tune Plus Window” on page 7-2
- “MALDI Source Dialog Box” on page 7-4
- “Calibrating MALDI LTQ Orbitrap Series Instruments” on page 7-8
- “Diagnostics for MALDI” on page 7-16
- “Instrument Setup” on page 7-18
- “Instrument Configuration” on page 7-19

Note In this guide, the expression \textit{LTQ Orbitrap Series} is used whenever an information is valid for the LTQ Orbitrap XL and the LTQ Orbitrap Discovery as well.

The screenshots in this chapter show the Tune Plus window for the MALDI LTQ Orbitrap XL. The information, however, is valid for all MALDI LTQ Orbitrap Series instruments. ▲
Tune Plus Window

Spectrum view, Graph view, and Status view show no differences to the standard instrument. They are described in Chapter 2: “Tune Plus Window”.

Status View

The Tune Plus window shows a schematic view of the MALDI LTQ Orbitrap Series instrument. The content of the Status view - All page is extended by information about pressure in the upper and the lower chamber, and by laser information. See Figure 7-1.

Figure 7-1. Status View for MALDI LTQ Orbitrap Series instrument
Scan Mode Menu

This section describes the elements of the Scan Mode menu that are different from the standard instrument.

Define Scan Dialog Box

As described in Chapter 2: “Tune Plus Window”, you can choose the analyzer type (ion trap or Orbitrap), mass resolution, and scan types. See Figure 7-2. You can as well define the scan range (First Mass–Last Mass window). Note that the Maximum Inject Time spin box in the Scan Time group box is disabled. For MALDI relevant aspects, refer to the MALDI Source Getting Started manual.

![Define Scan dialog box for MALDI](image)

**Figure 7-2.** Define Scan dialog box for MALDI
Setup Menu

This section describes the elements of the Setup menu that are different from the standard instrument.

Injection Control Dialog Box - FT Page

On the FT page of the Injection Control dialog box, use the default MS\(^n\) settings for FT detection as shown in Figure 7-3.

![Injection Control Dialog Box - FT Page](image)

**Figure 7-3.** FT injection control settings for MALDI

MALDI Source Dialog Box

The MALDI Source dialog box allows you to set up the MALDI source and to acquire data with it.

❖ **To open this dialog box**

- From the Tune Plus window, choose **Setup > MALDI Source**, or
- click on ![MALDI Source icon](image) in the Tune Plus toolbar.

Control Page

The MALDI Source dialog box – Control page groups frequently used control parameters. This page allows you to control the motion of the sample plate (Plate Motion), to define the number of microscans/step, laser energy, acquisition settings, and to monitor the video image of the sample plate. See Figure 7-4.
Setup Page

The MALDI Source dialog box - Setup page allows you to define plate motion conditions and the laser energy – as on the Control page. See Figure 7-5 on page 7-6. Additionally, you can define different thresholds for automatic spectrum filtering (ASF) for linear trap analyzer and Orbitrap analyzer. Furthermore, you can define a number of sweep laser shots. They occur before the actual analytical laser scans and help to clean an impure sample surface at a new spot (from unwanted alkali ions, for example). The MS detector does not collect data during a sweep laser shot.

Figure 7-4. MALDI Source dialog box – Control page
Acquire Page

The MALDI Source dialog box – Acquire page allows you to set up and acquire data with the MALDI source. See Figure 7-6 on page 7-7. You can acquire data from multiple sample spots. For each sample spot, the data is saved into a separate file. The plate position is automatically appended to the file name. Additionally, this page allows you to set the number of scans or the maximum time for acquisition.

**Note** The file information entered here for the sample plate is saved in memory until you remove the plate from the instrument.
The MALDI Source dialog box - Camera page allows you to view a large image from the camera. It can be helpful in finding a “sweet spot” in the sample spot and select it when Plate Motion is set to Manual (on the Control page or Setup page).

**Note** Choosing about 100 microscans/spot in manual mode gives reasonable time to select samples manually.

![Figure 7-6. MALDI Source dialog box – Acquire page](image)
Calibrating MALDI LTQ Orbitrap Series Instruments

This section describes the MALDI specific aspects of calibrating LTQ Orbitrap Series instruments.

ProteoMass MALDI Calibration Kit

Your system is delivered with the Sigma ProteoMass™ MALDI Calibration Kit. This kit can be reordered via Sigma-Aldrich (Product Code MS-CAL4).

The so-called Standard Mix (ProteoMass Normal Mass Calibration Mix, Product Code C 9241) calibrates all LTQ devices in the mass range up to \( m/z \ 2000 \) and all Orbitrap devices. Mostly it is used to perform mass calibration in Orbitrap’s mass range \( m/z \ 50–2000 \).

The so-called High Mix (ProteoMass High Mass Calibration Mix, Product Code C 9366) calibrates various LTQ devices for high mass range high \( (m/z \ 100–4000) \) and Orbitrap’s mass range \( m/z \ 200–4000 \).

The MALDI Source Getting Started manual describes how to prepare the calibration and sensitivity test spots. Follow the protocol that is contained in the kit to get your system (linear trap and Orbitrap) calibrated according to the MALDI source specification. With respect to the Orbitrap analyzer, this means:

- Small Mass Range \( (m/z \ 50–800) \),
- Universal Mass Range \( (m/z \ 150–2000) \), and
- High Mass Range \( (m/z \ 200–4000) \).

**Note** At present, calibrating for Orbitrap’s High Mass Range overwrites a previously performed mass calibration for Orbitrap’s Universal Mass Range with the mass range up to \( m/z \ 4000 \). There is no unique mass calibration for Orbitrap’s mass range \( m/z \ 200–2000 \).

For the above-listed mass ranges of MALDI LTQ Orbitrap Series instruments, there is a semi-automatic mass calibration for positive ion mode. It refers to the ions provided by the MALDI calibration solutions and it additionally uses ions of \( \alpha \)-cyano-4-hydroxy cinnamic acid (HCCA matrix). See Table 7-1 on page 7-9 for the exact masses of the ions contained in the ProteoMass MALDI Calibration Kit. This calibration is carried out in agreement to the mass calibration of the API source as described in Chapter 3: “Calibrating the Instrument for FTMS Measurements”.

---

**LTQ Orbitrap XL Getting Started**

Thermo Fisher Scientific
The FT Manual calibration page allows performing a mass calibration with user-defined settings. See page 7-13. A semi-automatic calibration is also provided for Storage Transmission for masses below \( m/z \) 2000 throughout all mass ranges. See page 7-10. FT Transmission calibration is performed in the factory.

### Table 7-1. Exact masses of calibration compounds (ProteoMass™ MALDI Calibration Kit; Sigma-Aldrich MS-CAL4)

<table>
<thead>
<tr>
<th>SEQUENCE</th>
<th>PEPTIDE</th>
<th>SUM FORMULA, MH+</th>
<th>MH+ m.i.M</th>
<th>MH+, av</th>
<th>(M-H)-, m.i.M</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSMEHFRWGKPVGKK</td>
<td>ACTH 1-16</td>
<td>C89 H134 N25 O22 S</td>
<td>1936.985048</td>
<td>1938.240577</td>
<td>1934.970490</td>
</tr>
<tr>
<td>DIGAVLKVLTGLPALISWIKRQQ</td>
<td>Mellitin</td>
<td>C131 H230 N39 O31</td>
<td>2845.761447</td>
<td>2847.476759</td>
<td>2843.746890</td>
</tr>
<tr>
<td>DRVYIHPFHL</td>
<td>Angiotensin</td>
<td>C62 H90 N17 O14</td>
<td>1296.684767</td>
<td>1297.486046</td>
<td>1294.670210</td>
</tr>
<tr>
<td>FRWGKPVGKRRPVKVYPNGAESAEAPLE</td>
<td>ACTH7_38</td>
<td>C167 H258 N47 O46</td>
<td>3657.928859</td>
<td>3660.130611</td>
<td>3655.914310</td>
</tr>
<tr>
<td>MRFA</td>
<td>MRFA</td>
<td>C23 H38 N7 O5 S</td>
<td>524.264964</td>
<td>524.658437</td>
<td>522.250410</td>
</tr>
<tr>
<td>RPPGFSPFR</td>
<td>Bradikinin</td>
<td>C50 H74 N15 O11</td>
<td>1060.568674</td>
<td>1061.218462</td>
<td>1058.554120</td>
</tr>
<tr>
<td>RPPGFSP</td>
<td>Bradikini 1-7</td>
<td>C35 H53 N10 O9</td>
<td>757.39915</td>
<td>757.858143</td>
<td>755.384600</td>
</tr>
<tr>
<td>DRVYIHPFHLLVYS</td>
<td>ReninSubstrate</td>
<td>C85 H124 N21 O20</td>
<td>1758.932601</td>
<td>1760.026359</td>
<td>1756.918048</td>
</tr>
<tr>
<td>pyroEIYENKPRPYI</td>
<td>Neurotensin</td>
<td>C78 H122 N21 O20</td>
<td>1672.916951</td>
<td>1673.935326</td>
<td>1670.902398</td>
</tr>
<tr>
<td>DHB</td>
<td></td>
<td>C7 H7 O4</td>
<td>155.03389 / 154.02606 / 137.02332</td>
<td>152.01151 / 153.01933</td>
<td></td>
</tr>
<tr>
<td>HCCA</td>
<td></td>
<td>C10 H8 O3 N1</td>
<td>190.04987</td>
<td>144.045487</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>172.0393</td>
<td>188.035320</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>379.09246</td>
<td>333.088080</td>
<td></td>
</tr>
</tbody>
</table>
Calibrating the Instrument for MALDI

This section describes how to calibrate MALDI LTQ Orbitrap Series instruments by using the various pages of the Calibrate dialog box.

Semi-Automatic Calibration for Small + Universal Mass Range

The Semi-Automatic page of the Calibrate dialog box (see Figure 7-7) allows you to select specific calibration parameters to calibrate, for example only the ion trap calibrations or only the FT calibrations. Via the Semi-Automatic page, positive ion mode calibration is achievable for storage transmission and mass calibration. For systems with an HCD collision cell, the Semi-Automatic page also provides positive ion mode calibration for HCD collision energy and HCD transmission. For negative mode calibration, refer to the topic “FT Manual Calibration Page” on page 7-13”.

Note It is recommended to perform a semi-automatic mass calibration only once a week. ▲

The instrument displays real-time messages in the Status box about the procedure that is currently running. See the following example for a mass calibration check of the Normal mass range:

09:52:19: Checking instrument calibration...
09:52:20: Running
09:52:20: External Mass Accuracy Check
09:52:20: universal mass range / positive ions
09:52:20: Reference masses m/z 172.039300 .. 1758.932601.
09:53:49: Result: 0.957679 ppm RMS. Ok.
09:53:52: Running
09:53:52: External Mass Accuracy Check
09:53:52: small mass range / positive ions
09:53:52: Reference masses m/z 172.039300 .. 757.399150.
09:55:28: Result: 0.624307 ppm RMS. Ok.
09:55:31: FT Mass Calibration (pos) Check PASSED
09:55:31:
09:55:31: Calibration is OK!

Additionally, the instrument displays the progress of each mass calibration in the Graph View. See Figure 7-8 (mass calibration of the Small Mass Range) and Figure 7-9 on page 7-12 (mass calibration of the Universal Mass Range).

![Graph View of Mass Calibration](image)

**Figure 7-8.** Mass calibration of the Small Mass Range
For the High Mass Range, Tune Plus provides a semiautomatic calibration for the positive ion mode and the negative ion mode. See Figure 7-10.
Automatic Calibration Page

The Automatic page of the Calibrate dialog box (see Figure 3-4 on page 3-13) allows you to calibrate the instrument in positive ion mode.

**Note** Usually you should not perform a complete ion trap calibration or an FT ion calibration unless the hardware is modified in some way. However, it is necessary to repeat the electron multiplier calibration every one to three months and the FT mass calibration once a week. Thus, in the most cases it is not recommended to perform an automatic calibration of the LTQ Orbitrap Series instrument because all calibrations are performed, which takes about 1 hour. To run a multiplier gain calibration or an FT mass calibration (which takes only some minutes), it is recommended to use the semiautomatic calibration.

Check Calibration Page

All calibration checks can be performed with the negative mode calibration solution or the mixtures contained in the ProteoMass MALDI Calibration Kit. Figure 7-11 shows the Graph View during a check of the mass calibration.

**Figure 7-11.** Checking the mass calibration (Normal Mass Range)

FT Manual Calibration Page

The FT Manual page of the Calibrate dialog box allows to perform or to check an FT mass calibration with user-defined calibration masses. See Figure 7-12 on page 7-14 and Figure 7-13 on page 7-15.
**Note** Starting from the FT Manual Page, the calibration is performed for the currently selected polarity only.

![Calibrate dialog box – FT Manual page: Normal Mass Range (NMR)](image)

**Figure 7-12.** Calibrate dialog box – FT Manual page: Normal Mass Range (NMR)

Because the FT Manual Calibration page allows using your own calibration masses, it is possible to use custom calibration solutions here. However, there are some requirements for the calibration masses. The scan ranges of the instrument need to be covered properly by the given masses.
Figure 7-13. Calibrate dialog box – FT Manual page: High Mass Range (HMR)
Diagnostics for MALDI

In general, diagnostic procedures for the LTQ Orbitrap Series instrument are described in Chapter 4: “Performing Diagnostics/Checks”. This section only contains information relevant for instruments equipped with the MALDI source. For additional information, see also the MALDI Source Getting Started manual.

The MALDI page in the Diagnostics dialog box allows you to perform evaluation tests on the MALDI system, including the video camera and sample plate. See Figure 7-14.

![Figure 7-14. MALDI page of the Diagnostics dialog box](image)

When you adjust the brightness and contrast of the video camera, the values are saved automatically. See below. When you run any of the other tests, the results of the test are returned as pass or fail.

The Video Camera Contrast and Brightness page in the Diagnostics dialog box contains two sliding bars for adjusting the appearance of the CCD camera display. The Brightness and Contrast slider bars adjust the CCD camera image. The Reset button restores the factory default values for brightness and contrast. See Figure 7-15 on page 7-17.
Figure 7-15. Video Camera Contrast and Brightness Test
Instrument Setup

This section takes a look at the “Locking” feature in automated runs. See also page 5-3 of a description of the FT relevant topics of the data dependent settings in the Instrument Setup.

Using Locking in Automated Runs

In order to use locking in an automated run, use the Instrument Setup program. See Figure 7-16.

Note Refer to topic “Locking” on page 2-12 for a basic description on using locking with FTMS analyzer scans.

Figure 7-16. Instrument Setup window for MALDI LTQ Orbitrap Series instrument

The Lock Mass List button in the segment settings group brings up a lock mass list editor dialog. Segment-related lock masses can be entered here. There are separate lists for positive ion and negative ion mode. If the lock mass for a segment is empty, no locking will be applied in the run and the external calibration will be used.
Instrument Configuration

This section gives instructions on how to configure your MALDI LTQ Orbitrap Series instrument. It contains the following topics:

- “Starting Instrument Configuration” on page 7-19
- “Instrument Configuration Dialog Box” on page 7-20
- “MALDI Source Configuration Dialog Box” on page 7-21

Starting Instrument Configuration

❖ To configure your LTQ Orbitrap Series instrument

1. From the Instrument Configuration window, click on LTQ Orbitrap XL MS in the Configured Devices group box. See Figure 7-17.

![Instrument Configuration window](image)

**Figure 7-17.** Instrument Configuration window
2. Click on **Configure** to open the LTQ Orbitrap Series Instrument Configuration dialog box.

**Instrument Configuration Dialog Box**

This section describes the MALDI source relevant features of the LTQ Orbitrap Series Instrument Configuration dialog box.

**Ion Source Page**

The Ion Source page of the Configuration dialog box allows you to enter inlet configuration parameters for your LTQ Orbitrap Series instrument. Choose the **MALDI** item in the Default source list box. See Figure 7-18.

![Figure 7-18. LTQ Orbitrap Series Configuration dialog box – Ion Source page](image)

**Display Page**

The Display page of the Configuration dialog box allows you to configure the number of decimal places to show for certain values in Tune Plus and methods. See Figure 7-19 on page 7-21.
MALDI Source Configuration Dialog Box

The MALDI Source Configuration dialog box displays the firmware version of the MALDI source and allows entering the serial number. See Figure 7-20.
Chapter 8 LTQ Orbitrap XL ETD Instruments

This chapter describes only the Orbitrap relevant differences in instrument settings and procedures with respect to using an LTQ Orbitrap XL ETD instrument. For further information, refer to the previous chapters of this manual and the LTQ Orbitrap XL ETD Hardware Manual.

This chapter contains the following topics:

- “Tune Plus Window” on page 8-2
- “Configuring the Reagent Ion Source” on page 8-8
- “Powering On the ETD Module and Viewing Reagent Ion Spectra” on page 8-10
- “Tuning the ETD Optics” on page 8-12
- “Performing an ETD Infusion Experiment” on page 8-25
- “Creating an Xcalibur Instrument Method That Uses ETD Activation” on page 8-33
- “Angiotensin I Solutions” on page 8-39

Note If your instrument is equipped with a reagent ion source, you need to configure the reagent ion source in Instrument Configuration to get access to all reagent ion source relevant settings of Tune Plus and Instrument Setup. See topic “Configuring the Reagent Ion Source” on page 8-8.
Tune Plus Window

This section describes the differences in the Tune Plus window of an LTQ Orbitrap XL ETD instrument. Spectrum view and Graph view show no differences to the standard instrument. They are described in Chapter 2: “Tune Plus Window”.

Status View

The Tune Plus window shows a schematic view of the LTQ Orbitrap XL ETD instrument. See Figure 8-1. The instrument control icon in the toolbar allows accessing parameters for the reagent ion source and the reagent ion optics.

Figure 8-1. Status View for LTQ Orbitrap XL ETD
The color of the Reagent Ion Source control icon indicates the status of the reagent ion source:

- Reagent ion source off
- Reagent ion source on

The status of the filament is shown in the Status view – All page.

The content of the Status view – All page is extended by information about FT Turbopump 4, reagent ion source, reagent ion optics, reagent vacuum, reagent turbopump, and reagent power supplies.

### Scan Mode Menu

This section describes the elements of the Scan Mode menu that are different from the standard instrument.

### Define Scan Dialog Box

As described in Chapter 2: “Tune Plus Window”, you can choose the analyzer type (Ion Trap or FTMS), mass range, resolution, and scan type. See Figure 8-2. You can as well define the scan range (for example, First Mass–Last Mass window).

![Define Scan dialog box for LTQ Orbitrap XL ETD](image.png)

**Figure 8-2.** Define Scan dialog box for LTQ Orbitrap XL ETD
When you select ETD as Activation Type in the MSn Settings, the Supplemental Activation check box becomes available. Select this check box to enable supplemental activation of ETD MS/MS and MS^n.

Use the SA Energy spin box to enter the percentage of the energy that should be used for supplemental activation. The available range is 0 to 20%.

Use the SA Charge State spin box to enter the charge state of the parent ion for supplemental activation. Available charge states are 2 to 10.

**Setup Menu**

This section describes the elements of the Setup menu that are different from the standard instrument.

**Injection Control Dialog Box – Reagent Page**

The number of reagent ions admitted into the linear trap is regulated by the parameters in the Reagent page in the Injection Control dialog box. See Figure 8-3. Open the Reagent page in the Injection Control window by clicking the Injection Control instrument control graphic or click **Setup > Injection Control > Reagent**.

![Injection Control dialog box – Reagent page](image)

**Figure 8-3.** Injection Control dialog box – Reagent page

See topic “Injection Control: Reagent Ion AGC Target and Ion Time Settings” on page 8-25 for information about the parameters available on this dialog box.
**Reagent Ion Optics Dialog Box**

The Reagent Ion Optics dialog box allows you to specify voltages for the reagent ion source lenses, the back lens, and the transfer multipole. Usually, the reagent ion optics parameters are optimized by the automatic tune procedure to maximize the transmission of reagent ions from the reagent ion source to the linear ion trap.

You may obtain small improvement in the signal by manual tuning and changing the settings. You can change the settings in this dialog box only after selecting the View Reagent Ion Spectra check box in the Reagent Ion Source dialog box. See Figure 8-4. See topic “Tuning the ETD Optics” on page 8-12 for more information.

![Reagent Ion Optics Dialog Box](image)

*Figure 8-4. Activating Reagent Ion Optics dialog box*

**Note** The reagent ion optics lenses have broad optimums – except the back lens. Increasing or decreasing the back lens offset by 3 or 4 V can significantly reduce the signal. ▲

**Reagent Ion Source Dialog Box**

The Reagent Ion Source dialog box allows you to set selected ETD reagent ion source parameters. See Figure 8-5 on page 8-6. The actual parameter values are shown on the right side of the dialog box.
Use the Reagent Ion Source On check box to turn on or off the reagent ion source, including the vial heaters. If the reagent vials are not at their target temperatures, a “Please Wait” message window appears. Typically, heating takes 5 to 10 minutes. Turn off the reagent ion source if you do not plan to use it for an extended period, overnight for example.

Use the Filament On check box to turn on or off the filament, which produces electrons. When the reagent vials reach their target temperatures, the filament automatically turns on and the Filament On check box automatically shows a check mark. (You can force the filament to turn on before the vials reach their target temperatures by selecting the check box.) To prolong the lifetime of the filament, turn it off if the reagent ion source will not be in use for an hour or more.

Click **Open Probe Interlock** to evacuate the inlet valve block to a target pressure of less than 0.1 mTorr. When the target pressure is achieved, a message states that you can open the ball valve. See the *LTQ Orbitrap XL ETD Hardware Manual* for maintenance instructions for the reagent ion source.

When you select the View Reagent Spectra check box, the following actions become possible:

- The injection of analyte ions, but not reagent ions, into the mass analyzer for mass analysis is stopped. This allows measuring reagent ion intensity and also checking for reagent contamination by observing the mass spectrum.
• You can change the parameter values in the Reagent Ion Optics dialog box. See page 8-5.

• You can autotune the reagent ion source. See page 8-12.

**Vacuum Dialog Box – Reagent Page**

The Reagent page of the Vacuum dialog box allows you to switch on the ion gauge in the ETD Module. It also displays the pressure readings of the ion gauge and the Convectron gauge in the ETD Module. See Figure 8-6.

![Vacuum dialog box](image)

**Figure 8-6.** Reagent page of the Vacuum dialog box
Configuring the Reagent Ion Source

After you have installed the reagent vials for the ETD Module as described in the *LTQ Orbitrap XL ETD Hardware Manual*, you have to configure the reagent ion source of your LTQ Orbitrap XL ETD instrument.

❖ To configure the reagent ion source

1. From the Instrument Configuration window, click on **LTQ Orbitrap XL MS** in the Configured Devices group box.

2. Click on **Configure** to open the LTQ Orbitrap XL Configuration dialog box.

3. Click **Reagent Ion Source** in the left hand section of the LTQ Orbitrap XL Configuration window. The Reagent Ion Source page of the Configuration dialog box allows you to configure the reagent ion source and to activate the cooling gas. See Figure 8-7.

4. Select the **Reagent Ion Source Configured** check box as shown in Figure 8-7.

5. In the Vial 1 row, click the Reagent Name list box and select Fluoranthene. The Fluoranthene Vial 1 Reagent Mass, Activation Type, and default Vial Temperature will appear in the table.

**Caution** The empty vial in the Vial 2 heater is an integral part of the carrier/CI gas system. It is necessary to keep the carrier/CI gas system closed to the laboratory. If no vial is placed in the Vial 2 heater:
• The carrier/CI gas containing the reagent may escape to the laboratory causing a safety problem.

• The ETD Module will not operate correctly and the filament will burn out. ▲

6. Select the Use Cooling Gas check box as shown in Figure 8-8.

![Figure 8-8. LTQ Orbitrap Series Configuration dialog box – Reagent Ion Source page](image)

7. Click **OK** in the LTQ Orbitrap XL Configuration dialog box.

8. Click **Done** in the Instrument Configuration window.

The system software is now configured for using the reagent ion source of the LTQ Orbitrap XL ETD system.
Powering On the ETD Module and Viewing Reagent Ion Spectra

After the reagent vials have been installed as described in the *LTQ Orbitrap XL ETD Hardware Manual*, power on the ETD Module by placing the LTQ Orbitrap XL ETD in On mode. Turn on the reagent ion source to view the reagent ion spectra.

Powering On the ETD Module

To power on the ETD Module, do the following

1. Toggle the ETD Module service switch to the Operating Mode (ON) position if it is not already in this position.

2. Toggle the LTQ Orbitrap XL MS FT Electronics switch to the On position. This turns the ETD Module on if the ETD Module service switch is already in the Operating Mode (ON) position.

For detailed instructions about starting up and shutting down the instrument, see the *LTQ Orbitrap XL ETD Hardware Manual*.

Turning On the Reagent Ion Source and Viewing Reagent Ion Spectra

❖ To turn on the reagent ion source

1. Click the Reagent Ion Source instrument control icon in the toolbar of the Tune Plus window. (See icon in margin and Figure 8-1 on page 8-2.) The Reagent Ion Source dialog box appears. (See Figure 8-5 on page 8-6.)

2. In the Reagent Ion Source dialog box, click the Reagent Ion Source On check box. (See Figure 8-5.) If the reagent vials are not at their target temperature, a message box appears. See Figure 8-9. When the reagent vials reach their target temperature, voltage is applied to the ETD Module ion optics. The filament automatically turns on; the Filament On check box automatically shows a check mark and its actual condition switches from Off to On.

![Figure 8-9. Message box: Reagent Vial NOT At Temperature!](image-url)
Viewing Reagent Ion Spectra

❖ To view the reagent ion spectra

1. Select the View Reagent Ion Spectra check box in the Reagent Ion Source dialog box. See Figure 8-10.

2. Reagent ion peaks appear in the Spectrum view. See Figure 8-10.

---

Figure 8-10. Tune Plus window showing the fluoranthene radical anion mass spectrum
Tuning the ETD Optics

This section describes how to tune the ETD Reagent Ion Optics settings to obtain optimized reagent ion transmission.

Autotuning The Reagent Ion Source

Automatically tuning the reagent ion source assures the best ion optics settings for optimum transmission of reagent ions (fluoranthene).

❖ To automatically tune the reagent ion source

1. Open the Tune Plus window.
2. If the reagent ion source is not on, turn it on as described in topic “Turning On the Reagent Ion Source and Viewing Reagent Ion Spectra” on page 8-10.
3. In the Reagent Ion Source dialog box, select the View Reagent Ion Spectra check box. (See Figure 8-11.)
4. Click the Tune button. (See icon in margin.) The Tune dialog box appears.
5. The left side of the underlying view shows the Reagent Ion Spectra (fluoranthene). See Figure 8-12. The center view shows one of the...
parameters that are automatically tuned (back lens potential tuned to maximize the signal intensity at \( m/z \) 202).

6. Click the Automatic tab in the Tune dialog box if it is not already the active tab. The Automatic page of this window appears.

7. Click Start in the Automatic page of the Tune dialog box. The system will begin automatically tuning the ion optics of the reagent ion source. The Status box of the dialog box indicates that automatic tuning is completed by displaying the message, “Optimization Complete”. This message will also indicate the percentage change in the reagent ion signal intensity at \( m/z \) 202 relative to the prior value. A typical reagent signal intensity is about 1–2E7 in centroid mode when the system has been cleaned and the ion volume is new.

8. Rerun Automatic Tune if the percentage change is greater than 20%. This is an iterative process. At some point there will be no more improvements in signal intensity.

Figure 8-12. Tune Plus window with Automatic page of Tune dialog box displayed
Automatically tuning the reagent ion source is the best method for most situations. In some cases it may be appropriate to perform manual tuning. Choose manual tuning to manually optimize reagent ion optics parameters and reagent ion source parameters that are not automatically tuned such as Emission Current, Electron Energy, and CI gas pressure. Manual tuning is done by observing the effects of adjusting these parameters on the reagent ion signal intensity.

**Note** Tune Plus provides an evaluation procedure for CI gas pressure under **Diagnostics > Diagnostics > Tools > System evaluation > Reagent CI gas pressure evaluation**. Thermo Fisher Scientific recommends performing this procedure after replacing the filament and/or the ion volume.

### Manually Tuning the Reagent Ion Source

1. Click the Display Graph View icon in Tune Plus.

2. If the reagent ion source is not on, open the Reagent Ion Source dialog box and turn on the reagent ion source as described in topic “Turning On the Reagent Ion Source and Viewing Reagent Ion Spectra” on page 8-10.

3. In the Reagent Ion Source dialog box, select the View Reagent Ion Spectra check box. See Figure 8-10 on page 8-11.

4. Click the Reagent Ion Optics icon at the top of the Tune Plus window. (See icon in margin and Figure 8-13.) The Reagent Ion Optics dialog box appears.
5. Click the **Tune** button in Tune Plus. The Tune dialog box appears. You can also tune the reagent ion source. When the Reagent Ion Source dialog box is open (Figure 8-5), click on the **Tune** button in Tune Plus.

6. Click the **Manual** tab in the Tune dialog box if the Manual page is not already visible. (See Figure 8-14 on page 8-16.)

7. Select the **Reagent Ion from Vial 1** check box.
8. Click **Start**.

   The display graph view displays a plot of the reagent ion intensity. See Figure 8-15 on page 8-17. You can observe the response of the reagent ion intensity to changes in the lens parameters (Reagent Ion Optics dialog box) and Emission Current, CI gas flow, and Electron Energy (Reagent Ion Source dialog box). Adjust these parameters to achieve the maximum reagent ion signal intensity.

**Note** Increasing the emission current might shorten the filament lifetime. Therefore, Thermo Fisher Scientific recommends readjusting the emission current only in exceptional circumstances.
Viewing the Current Reagent Ion Optics Settings

❖ To view the current Reagent Ion Optics settings

1. Click the Reagent Ion Optics instrument control icon in the Tune Plus window to open the Reagent Ion Optics dialog box. The parameters in the Reagent Ion Optics dialog box have been optimized by the Auto Tune process. See Figure 8-16 on page 8-18.

Note When the View Reagent Ion Spectra check box in the Reagent Ion Source dialog box is not selected, the parameters in the Reagent Ion Optics dialog box cannot be changed. ▲
2. Click **OK** to close the Reagent Ion Optics dialog box.

**Saving Your ETD Tune Method**

After either automatic or manual tuning (See topic “Turning On the Reagent Ion Source and Viewing Reagent Ion Spectra” on page 8-10.), save the ETD Tune parameters in a tune method. To save in the currently used tune file, click **File > Save** in Tune Plus. To save the parameters under a specific name, click **File > Save As**, enter the desired file name, and save this file to the desired location.

**Tuning the Quadrupole Mass Filter**

Stable calibration of the quadrupole mass filter between the linear ion trap and the C-Trap is achieved by manually adjusting the Back Multipole DC Offset voltage.
To adjust the Back Multipole DC Offset voltage

1. Open the Toggles page in the Diagnostics dialog box.
2. Set FT HCD collision gas to On to switch on the collision gas in the HCD cell.
3. Set Isolate reagent ion to On. See Figure 8-17.

4. In the Reagent Ion Source dialog box, select the View Reagent Ion Spectra check box.
5. Open the Tune dialog box and perform a semi-automatic tune of the Back Multipole Offset with the settings shown in Figure 8-18 on page 8-20 (Start 0, End 40, Step 0.35).
6. Search for a local maximum just before the oscillations on the signal start. (In the example shown in Figure 8-20, that would be at about 17 V).

7. Open the Reagent Ion Optics dialog box. Enter the new value for the Back Multipole Offset voltage into the respective spin box and click **Apply**.

8. Open the Calibrate dialog box and perform a semi-automatic calibration of the Reagent Ion Selection. See Figure 8-19 on page 8-21 and Figure 8-22 on page 8-23.

**Figure 8-18.** Semi-automatic tune of the Back Multipole Offset dc voltage
Choosing the Operating Point for the Quadrupole Mass Filter

The performance of the quadrupole mass filter strongly depends on the kinetic energy (that is, DC Offset) of the ions. If the kinetic energy is too low it causes a poor transmission; if the kinetic energy is too high it leads to oscillations (noding) of the signal.

In the example shown in Figure 8-20, noding starts at above 20 V. In this region, the signal is fragile. Depending on the DC Offset (for comparison: 10 V, 17 V, and 32 V; red points) the calibration curves look differently.

The best operating point for the filter is the immediate region before the oscillations start. In the example, that would be the range between 15 V and 20 V.

Figure 8-19. Calibrating the Reagent Ion Selection
If the DC Offset is chosen too low, intensity losses in the filter are too large. During the calibration, the signal still increases after the stable region is reached. See Figure 8-21. As a consequence, the transmission at the operating point of the filter is poor.

With offset voltages between 15 V and 20 V, no noding is visible. See Figure 8-22. The transmission reaches a maximum shortly after the start of the stable region, resulting in a high transmission at optimum filter efficiency. The calibration results in a broad plateau with constant intensity.
If the DC Offset is chosen too low, strong oscillation on the signal occur. See Figure 8-23. This creates problems when calibrating the filter. Because the maxima are very narrow, the anion signal is susceptible to changes of the ion optics (thermal drift of voltages, deterioration of the reagent source, etc.) Therefore, this region is not suitable for stable operation of the ETD system even though it may include the maximum of the anion intensity.

Figure 8-22. Point of optimum performance

Figure 8-23. Chosen DC Offset (32 V) is too high for calibration
“Noding” in Quadrupoles

In quadrupole filters, the intensity of the nodes increases with the kinetic energy of the ions. See Figure 8-24.

Figure 8-24. “Noding” in quadrupoles

Depending on the location of the nodes, the ions leave the quadrupole as an either convergent beam (good transmission) or divergent beam (bad transmission). Tuning the voltages moves the place of the nodes, leading to oscillations of the signal.
Performing an ETD Infusion Experiment

Procedures for performing an ETD infusion experiment are described in the following sections:

- Injection Control: Reagent Ion AGC Target and Ion Time Settings
- Obtaining an ETD Spectrum for Angiotensin I
- Optimizing the Reagent Ion Reaction Time

Injection Control: Reagent Ion AGC Target and Ion Time Settings

The number of reagent ions admitted into the linear ion trap is regulated by the parameters in the Reagent page of the Injection Control dialog box. See Figure 8-25. Open the Reagent page of the Injection Control window by clicking the Injection Control instrument control graphic or click Setup > Injection Control > Reagent.

![Injection Control dialog box – Reagent page](image)

The ETD Reagent Injection control consists of two parameters, the Reagent Ion Automatic Gain Control (AGC) Target value and the Maximum Injection time. The AGC Target value sets the target number of reagent anions to be injected into the linear ion trap in order to perform ETD. The default value for this parameter is 3E5.

The Maximum Injection time specifies the maximum amount of time that the system allows for anions to be injected into the trap. The default value for this time is 50 ms.

The reagent ion source injects reagent anions into the linear ion trap until the ETD AGC target is reached. The time allowed to reach the ETD AGC target cannot exceed the Maximum Injection time (the Maximum Injection time takes precedence over the AGC target). If the
AGC target is not reached due to the Maximum Injection time limit, the system displays an error message advising you that the AGC target has not been reached within the specified time limit (Maximum Injection time limit exceeded). This implies that the sensitivity of the reagent ion source is too low. To deal with this error, try the following procedures:

1. To increase the sensitivity of the source, run automatic tuning of the Reagent Ion Source. (See topic “Autotuning The Reagent Ion Source” on page 8-12.)

2. The sensitivity decrease might be due to a dirty ion volume. A sufficiently contaminated ion volume causes the Maximum Injection time limit to be exceeded. Clean or change the ion volume. See the LTQ Orbitrap XL ETD Hardware Manual for the procedure to do this.

3. The decrease of the signal might be due to a deformed filament. Change the filament. See the LTQ Orbitrap XL ETD Hardware Manual for the procedure to do this.

4. The sensitivity decrease might be due to a dirty reagent ion source and its optics. A sufficiently contaminated reagent ion source and its optics causes the Maximum Injection time limit to be exceeded. Clean or change the reagent ion source and its optics. See the LTQ Orbitrap XL ETD Hardware Manual for the procedure to do this.

5. Increase the emission current. However, doing this might shorten the filament life time.

6. Increase the Maximum Injection time limit. This is a temporary way to eliminate the error message. The Maximum Injection time limit can be increased up to the limits imposed by the overall scan cycle time.

Maximum Injection Time limit and AGC Target influence the scan duration when obtaining an ETD spectrum.

Obtaining an ETD Spectrum for Angiotensin I

This section assumes that you are infusing Angiotensin I into the LTQ Orbitrap XL ETD according to the procedures in the LTQ XL Getting Started manual. The recipe for this solution is given in topic “Angiotensin I Solutions” on page 8-39.

❖ To obtain an ETD spectrum of Angiotensin I

1. Open the Tune Plus application. The Tune Plus window appears.
2. Click **On/Off/Standby** to On. The mass spectrometer scans the infused analyte and produces a mass spectrum. See Figure 8-26.

3. Turn on the reagent ion source as explained in topic “Turning On the Reagent Ion Source and Viewing Reagent Ion Spectra” on page 8-10.

4. Click **Define Scan** to display the Define Scan dialog box. See Figure 8-27 on page 8-28.

5. Enter the parent ion $m/z$ of the $3^+$ charge state of Angiotensin I in the $n=2$ line of the Define Scan dialog box.

**Note** The molecular weight of Angiotensin I (acetate hydrate) is 1296 u and the $(M + 3H)^{3+}$ parent is giving rise of a signal at $m/z$ 433.0. ▲
6. Select **ETD** from the Activation Type list box in the Define Scan dialog box.

7. Click **Apply** in the Define Scan dialog box.

8. Click **OK** in the Define Scan dialog box. The Define Scan dialog box closes and the ETD MS/MS spectrum of Angiotensin I appears in the Tune Plus window. See Figure 8-28 on page 8-29.
Optimizing the Reagent Ion Reaction Time

Typically, the system default Reagent Ion Reaction Time of 100 ms is appropriate for doubly charged ions. In some cases it is helpful to obtain an optimized Reagent Ion Reaction Time for your specific analyte, especially for ions with higher charge states. The procedures presented in this topic assume that your system is generating the reagent ions as described in topic “Turning On the Reagent Ion Source and Viewing Reagent Ion Spectra” on page 8-10.

♦ To obtain an optimized reagent ion reaction time

1. Turn on ETD activation for the analyte of interest (Angiotensin I in this case).

2. Open the Define Scan window.

3. Click **Tune**. See Figure 8-29 on page 8-30.
4. Click the **Reagent Ion Reaction Time** tab in the Tune dialog box. See Figure 8-29.

5. Optimize on either the total ion current of the product ions (TIC) or the \(m/z\) of particular product ions.
   - Optimize on the total ion current (TIC) of the product ions:
     i. Click **TIC** in the What To Optimize On section of the Tune dialog box. (See Figure 8-29.)
     ii. Click **Start**. The software generates a graph of the product ion TIC versus reaction time. The Status box of the Tune dialog box shows the optimized reagent ion reaction time after the Tune process is completed.
     iii. A pop up dialog asks if you want to accept the optimized value. If you accept the optimized value, the reagent ion reaction time is set to this optimized value in the Define Scan dialog box. Otherwise, it is restored to its previous value.
The reagent ion reaction time is now optimized based on the total ion current.

- Optimize on the m/z of product ions:
  i. Click **Product Ion Mass** in the What To Optimize On section of the Tune dialog box. See Figure 8-30. The spin box adjacent to Product Ion Mass becomes active.
  ii. Enter the m/z of the fragment of interest into the spin box.
  iii. Click **Start**. The software generates a graph of intensity of the m/z of interest versus reaction time. The Status box of the Tune dialog box shows a reagent ion reaction time after the Tune process is completed.
  iv. A pop up dialog asks if you want to accept the optimized value. If you accept the optimized value, the reagent ion reaction time is set to this optimized value in the Define Scan dialog box. Otherwise, it is restored to its previous value.
The reagent ion reaction time is now optimized based on a particular $m/z$ of product ions.
Creating an Xcalibur Instrument Method That Uses ETD Activation

❖ To create an Xcalibur instrument method that uses ETD activation

1. Open the Xcalibur application (for example, from the Windows desktop). The Roadmap Home Page appears. See Figure 8-31.

2. Click the Instrument Setup icon in the Roadmap Home Page.

3. Click General MS or MSn in the Select Experiment Type section of the New Method view. See Figure 8-32 on page 8-34.
4. Click the **MS Detector Setup** tab if this is not already the selected tab in the Untitled-Instrument Setup window. See Figure 8-33.

5. Load the appropriate Tune Method (for example, a method saved as described in topic “Saving Your ETD Tune Method” on page 8-18).
6. Choose Scan Events to be 2 or more in the Segment 1 Settings portion of the MS Detector Setup view. See Figure 8-34 on page 8-36.

7. Select the Scan Event 2 bar (or the bar for a Scan Event >2). See Figure 8-34.
8. Select the **Dependent Scan** check box at the lower left corner of the MS Detector Setup view. (See **Figure 8-34**.) The adjacent **Settings** button becomes active.

9. Click **Settings**. A Data Dependent Settings dialog box appears. See **Figure 8-35** on page 8-37.
10. In the Data Dependent Settings dialog box, do the following:

   a. Choose **Scan Event > Activation** in the menu on the left side of the window.

   b. Select an Activation Type. Choose **ETD**, **CID** or **PQD**. The choice of Activation Type may be different for each Scan Event.

   c. For **Default Charge State** use values of 2 or more.

   d. For **Isolation Width** use values between 2 and 4.

   e. The Activation Time is either left at its default value or chosen as discussed in topic “Optimizing the Reagent Ion Reaction Time” on page 8-29.

   f. Click on **OK** to close the Data Dependent Settings dialog box.
11. Click **File > Save As** to save your Xcalibur method under the file name of your choice. (See Figure 8-36.) This method can be chosen and run when Sequence Setup is chosen in the Xcalibur Roadmap Home Page. (See Figure 8-31 on page 8-33.) Refer to your Xcalibur software online Help and the previous chapters of this manual for information about the other Data Dependent settings.
Angiotensin I Solutions

This section provides instructions for the preparation of solutions containing Angiotensin I (acetate hydrate). A stock solution is diluted to make a test solution. The test solution is used to demonstrate the application of the LTQ Orbitrap XL ETD and to optimize the reagent ion reaction time.

Handle Angiotensin I in accordance with its Material Safety Data Sheet (MSDS).

Caution Store and handle all chemicals in accordance with standard safety procedures. The Material Safety Data Sheet (MSDS) describing the chemicals being used should be freely available to laboratory personnel for them to examine at any time. Material Safety Data Sheets provide summarized information on the hazard and toxicity of specific chemical compounds. MSDSs also provide information on the proper handling of compounds, first aid for accidental exposure, and procedures for cleaning spills or dealing with leaks.

Producers and suppliers of chemical compounds are required by law to provide their customers with the most current health and safety information in the form of an MSDS. Read the MSDS for each chemical you use. Dispose of all laboratory reagents in the appropriate way (see the MSDS).

The Angiotensin I in your ETD Reagent Kit (Thermo Reagent Kit P/N 98000-62008, Thermo Angiotensin P/N 00301-15517) is Sigma/Aldrich #A9650.

The Angiotensin I MSDS is obtained by clicking the MSDS link at: www.sigmaaldrich.com/catalog/search/ProductDetail/SIGMA/A9650

Other potentially hazardous chemicals used in the procedures in this section include:

- Glacial acetic acid
- Methanol

Handle these chemicals in accord with their MSDS documents.

Preparing the Angiotensin I Stock Solution

❖ To prepare 772 μL of a Stock solution of 1 nanomol/μL Angiotensin I in 1% acetic acid – 50:50 methanol:water

1. Obtain the 1 mg vial of Angiotensin I in your accessory kit.
2. Add 382 μL of water, 382 μL of methanol, and 8 μL of glacial acetic acid to the 1 mg of Angiotensin I.

3. Ensure that the Angiotensin I is thoroughly dissolved.

4. Label the vial *Angiotensin I stock solution* and store it in a freezer until it is needed.

### Preparing the Angiotensin I Test Solution

❖ To prepare 20 mL of a sample solution of 1 picomol/μL Angiotensin I in 1% acetic acid – 50:50 methanol:water

1. Pipet 100 μL of the stock solution (1nmol/μL) of Angiotensin I into a clean polypropylene microcentrifuge tube.

2. Add 900 μL of 50:50 methanol/water (0.1% acetic acid) to the tube.

3. Mix this solution (100 pmol/μL) thoroughly.

4. Pipet 19.8 mL of 0.1% acetic acid – 50:50 methanol/water into a clean 20 mL glass scintillation vial.

5. Add 200 μL of the 100 pmol/μL solution into the scintillation vial to bring the final volume to 20 mL.

6. Mix this 1 pmol/μL solution thoroughly.

7. Label the vial *Angiotensin I test solution* and store it in a freezer until it is needed.
Appendix A  Miscellaneous Information

This appendix contains supplemental information for the previous chapters. It contains the following topics:

- “FT Analyzer Information in Scan Header” on page A-2
- “Data Size of FT Raw Files” on page A-4
FT Analyzer Information in Scan Header

The Qual Browser window allows you to open a raw file and to display scan header information for a selected scan in any of the cells. Choose View > Scan Header to display the Scan Header of the current scan in the active cell.

FT Analyzer Settings

The scan header information of an FTMS scan includes information about the FT Analyzer Settings that is not available in the usual Reports (Tune method, Instrument method, Status log, or Error log):

- **T=1e5**
  - AGC Target for this scan (here: 1e+05)
- **PsIT=0.65**
  - Prescan Inject Time (here: 0.65 ms)
- **Tog=(…)**
  - Manual diagnostic toggles are set different from their default values. See Table A-1 below for detailed information.
- **iWf**
  - Inject waveform on for this scan.
- **PvR=2e4**
  - Preview analysis active for this scan
- **DiagManualSettings**
  - Calibration parameters were manually changed under Diagnostics.

<table>
<thead>
<tr>
<th>Tog = (…)</th>
<th>Relevant Toggle</th>
<th>Current setting</th>
<th>Default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApoOff</td>
<td>FT apodization</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>TrExp</td>
<td>FT include transient</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>FullP</td>
<td>FT profile mode</td>
<td>Full</td>
<td>Reduced</td>
</tr>
<tr>
<td>IWFoff</td>
<td>FT SIM and MS(^3) injection waveforms</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>Freq</td>
<td>FT view frequency</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>Offset</td>
<td>FT zero offset</td>
<td>On</td>
<td>Off</td>
</tr>
</tbody>
</table>

Table A-1. Actual settings of manual toggles
FT Analyzer Messages

The scan header of an FT scan includes also so-called FT Analyzer Messages:

- **RF=1535V**  
  RF amplitude value (here: 1535 V)

- **HCD=148eV**  
  HCD collision energy in eV (here: 148 eV)

- **Ufill=0.45**  
  Maximum ion time reached. Here: the real number of ions is only ~45% of the target value.

- **MCal=4d**  
  Last mass calibration for this scan range is several days old (here: 4 days)

- **Est=0x24**  
  Machine-readable result message for post-processing tools

- **DAC=0.98**  
  FT transient measurement near saturation, this might result in spectral harmonics (typically target value too high)

- **TCal=[195..]**  
  This is a hint that the current scan range settings for the FT analyzer are outside the calibrated storage/transfer mass range. Transfer parameters are extrapolated.

- **Lock=(inj524.3,1/1,+3ppm)**  
  Information about lock mass settings, extra SIM injection of lock mass ions, number of identified lock masses in the spectrum, and deviation of corrected (locked) masses compared to the external mass calibration.

- **Stable=15min**  
  Shows the elapsed stabilization time of the FTMS analyzer high voltage electronics after last off state or polarity switch. For best external mass accuracies, it is required to let the FTMS analyzer high voltage electronics stabilize before performing an acquisition or mass calibration.
TempDiff=1  There is a temperature difference in the FTMS analyzer temperature between mass calibration time and current state. This may be caused by setting a different analyzer temperature setpoint in instrument configuration, by rapid significant changes in the ambient temperature, or by not waiting for temperature stabilization after instrument (temperature regulation) was off.

PkOvf  Internal Peak detection overflow in the FT spectrum analysis

Note  The actual FT Analyzer Messages can also be displayed in the Tune Spectrum view, see topic “Spectrum View” on page 2-3.

Data Size of FT Raw Files

The data size of a raw file with FT data depends on many parameters: for example, on the number of scans, the resolution setting, and the data format.

Table A-2 below displays typical data sizes (per scan) of an FT spectrum (negative mode calibration solution, scan range \( m/z \) 120–1200, AGC target 5E5, 1 microscan, resolution setting 60000) at different FT data formats.

<table>
<thead>
<tr>
<th>FT Data Format</th>
<th>Typical data size / scan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Centroid</td>
<td>ca. 10 kB</td>
</tr>
<tr>
<td>Reduced Profile</td>
<td>ca. 20 kB</td>
</tr>
<tr>
<td>Full Profile</td>
<td>ca. 2800 kB</td>
</tr>
</tbody>
</table>
# Glossary

This section lists and defines terms used in this manual. It also includes acronyms, metric prefixes, symbols, and abbreviations.

| A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z |
| A | ampere | ac | alternating current | ADC | analog-to-digital converter | adduct ion | An ion formed by the joining together of two species, usually an ion and a molecule, and often within the ion source, to form an ion containing all the constituent atoms of both species. | AGC™ | See Automatic Gain Control™ (AGC). | APCI | See atmospheric pressure chemical ionization (APCI). | APCI corona discharge current | The ion current carried by the charged particles in the APCI source. The voltage on the APCI corona discharge needle supplies the potential required to ionize the particles. The APCI corona discharge current is set; the APCI corona discharge voltage varies, as required, to maintain the set discharge current. | See also corona discharge and APCI corona discharge voltage. | APCI corona discharge voltage | The high voltage that is applied to the corona discharge needle in the APCI source to produce the APCI corona discharge. The corona discharge voltage varies, as required, to maintain the set APCI spray current. | See also APCI spray current. | APCI manifold | The manifold that houses the APCI sample tube and nozzle, and contains the plumbing for the sheath and auxiliary gas. | APCI needle, corona discharge | A needle to which a sufficiently high voltage (typically ±3 to ±5 kV) is applied to produce a chemical ionization plasma by the corona discharge mechanism. | See also chemical ionization (CI), chemical ionization (CI) plasma, atmospheric pressure chemical ionization (APCI), and corona discharge. | APCI nozzle | The nozzle in the APCI probe that sprays the sample solution into a fine mist. | See also atmospheric pressure chemical ionization (APCI). | APCI sample tube | A fused silica tube that delivers sample solution to the APCI nozzle. The APCI sample tube extends from the sample inlet to the APCI nozzle. | See also atmospheric pressure chemical ionization (APCI), and API stack. | APCI source | Contains the APCI probe assembly, APCI manifold, and API stack. | See also atmospheric pressure chemical ionization (APCI), APCI manifold, and API stack. | APCI spray current | The ion current carried by the charged particles in the APCI source. The APCI corona discharge voltage varies, as required, to maintain the set spray current. | APCI vaporizer | A heated tube that vaporizes the sample solution as the solution exits the sample tube and enters the atmospheric pressure region of the APCI source. | See also atmospheric pressure chemical ionization (APCI). |
API  See atmospheric pressure ionization (API).

API atmospheric pressure region  The first of two chambers in the API source. Also referred to as the spray chamber.

API capillary-skimmer region  The area between the capillary and the skimmer, which is surrounded by the tube lens. It is also the area of first-stage evacuation in the API source.

API heated capillary  A tube assembly that assists in desolvating ions that are produced by the ESI or APCI probe.

API heated capillary voltage  The dc voltage applied to the heated capillary. The voltage is positive for positive ions and negative for negative ions.

API ion transfer capillary  A tube assembly that assists in desolvating ions that are produced by the ESI, NSI, or APCI probe.

API ion transfer capillary offset voltage  A dc voltage applied to the ion transfer capillary. The voltage is positive for positive ions and negative for negative ions.

API ion transfer capillary temperature  The temperature of the ion transfer capillary, which should be adjusted for different flow rates.

API source  The sample interface between the LC and the mass spectrometer. It consists of the API probe (ESI or APCI) and API stack.

API spray chamber  The first of two chambers in the API source. In this chamber the sample liquid exits the probe and is sprayed into a fine mist (ESI or NSI) or is vaporized (APCI) as it is transported to the entrance end of the ion transfer capillary.

API spray shield  A stainless steel, cylindrical vessel that, in combination with the ESI or APCI flange, forms the atmospheric pressure region of the API source.

API stack  Consists of the components of the API source that are held under vacuum and includes the API spray shield, API ion transfer capillary, API tube lens, skimmer, the ion transfer capillary mount, and the tube lens and skimmer mount.

APPI  See Atmospheric Pressure Photoionization (APPI).

ASCII  American Standard Code for Information Interchange.

atmospheric pressure chemical ionization (APCI)  A soft ionization technique done in an ion source operating at atmospheric pressure. Electrons from a corona discharge initiate the process by ionizing the mobile phase vapor molecules. A reagent gas forms, which efficiently produces positive and negative ions of the analyte through a complex series of chemical reactions.

See also atmospheric pressure ionization (API), ESI source, APCI source, ESI probe, and API stack.

See also atmospheric pressure ionization (API) and API source.

See also API stack.

See also atmospheric pressure ionization (API) and API source.

See also API source and API ion transfer capillary.

See also API source and API ion transfer capillary.

See also API tube lens offset voltage, API source, API ion transfer capillary, and adduct ion.

See also API tube lens offset voltage, API source, API ion transfer capillary, and adduct ion.

See also API tube lens offset voltage.

See also API tube lens, adduct ion, and source CID.

See also atmospheric pressure ionization (API), ESI source, APCI source, ESI probe, and API stack.

See also atmospheric pressure ionization (API) and API source.

See also atmospheric pressure ionization (API).

See also atmospheric pressure ionization (API) and API source.
atmospheric pressure ionization (API)  Ionization performed at atmospheric pressure by using atmospheric pressure chemical ionization (APCI), electro spray ionization (ESI), or nanospray ionization (NSI).

Atmospheric Pressure Photoionization (APPI)  A soft ionization technique in which an ion is generated from a molecule when it interacts with a photon from a light source.

Automatic Gain Control™ (AGC)  Sets the ion injection time to maintain the optimum quantity of ions for each scan. With AGC on, the scan function consists of a prescan and an analytical scan.

auxiliary gas  The outer-coaxial gas (nitrogen) that assists the sheath (inner-coaxial) gas in dispersing and/or evaporating sample solution as the sample solution exits the APCI, ESI, or H-ESI nozzle.

auxiliary gas flow rate  The relative rate of flow of auxiliary gas (nitrogen) into the API source reported in arbitrary units.

auxiliary gas inlet  An inlet in the API probe where auxiliary gas is introduced into the probe.

auxiliary gas plumbing  The gas plumbing that delivers outer coaxial nitrogen gas to the ESI or APCI nozzle.

auxiliary gas valve  A valve that controls the flow of auxiliary gas into the API source.

B  

b  bit

B  byte (8 b)

baud rate  data transmission speed in events per second

BTU  British thermal unit, a unit of energy

C  

°C  degrees Celsius

CE  central electrode (of the Orbitrap)

cfm  cubic feet per minute

chemical ionization (CI)  The formation of new ionized species when gaseous molecules interact with ions. The process can involve transfer of an electron, proton, or other charged species between the reactants.

chemical ionization (CI) plasma  The collection of ions, electrons, and neutral species formed in the ion source during chemical ionization.

See also chemical ionization (CI).

CI  See chemical ionization (CI).

CID  See collision-induced dissociation (CID).

CLT  curved linear trap

cm  centimeter

cm³  cubic centimeter

collision gas  A neutral gas used to undergo collisions with ions.

collision-induced dissociation (CID)  An ion/neutral process in which an ion is dissociated as a result of interaction with a neutral target species.

consecutive reaction monitoring (CRM) scan type  A scan type with three or more stages of mass analysis and in which a particular multi-step reaction path is monitored.

Convectron™ gauge  A thermocouple bridge gauge that is sensitive to the pressure as well as the thermal conductivity of the gas used to measure pressures between X and Y.

corona discharge  In the APCI source, an electrical discharge in the region around the corona discharge needle that ionizes gas molecules to form a chemical ionization (CI) plasma, which contains CI reagent ions.

See also chemical ionization (CI) plasma and atmospheric pressure chemical ionization (APCI).

CPU  central processing unit (of a computer)

CRM  See consecutive reaction monitoring (CRM) scan type.

C-Trap  curved linear trap

<Ctrl>  control key on the terminal keyboard
Glossary:

D

d depth
Da dalton
DAC digital-to-analog converter
damping gas Helium gas introduced into the ion trap mass analyzer that slows the motion of ions entering the mass analyzer so that the ions can be trapped by the RF voltage fields in the mass analyzer.
data-dependent scan A scan mode that uses specified criteria to select one or more ions of interest on which to perform subsequent scans, such as MS/MS or ZoomScan.
dc direct current
divert/inject valve A valve on the mass spectrometer that can be plumbed as a divert valve or as a loop injector.
DS data system
DSP digital signal processor

E

ECD See electron capture dissociation (ECD).
EI electron ionization
electron capture dissociation (ECD) A method of fragmenting gas phase ions for tandem mass spectrometric analysis. ECD involves the direct introduction of low energy electrons to trapped gas phase ions.
See also electron transfer dissociation (ETD) and infrared multiphoton dissociation (IRMPD).
electron multiplier A device used for current amplification through the secondary emission of electrons. Electron multipliers can have a discrete dynode or a continuous dynode.
electron transfer dissociation (ETD) A method of fragmenting peptides and proteins. In electron transfer dissociation (ETD), singly charged reagent anions transfer an electron to multiply protonated peptides within the ion trap mass analyzer. This leads to a rich ladder of sequence ions derived from cleavage at the amide groups along the peptide backbone. Amino acid side chains and important modifications such as phosphorylation are left intact.
See also fluoranthene.
electrospray ionization (ESI) A type of atmospheric pressure ionization that is currently the softest ionization technique available to transform ions in solution into ions in the gas phase.

EMBL European Molecular Biology Laboratory
<Enter> Enter key on the terminal keyboard
ESD electrostatic discharge

ESI See electrospray ionization (ESI).

ESI flange A flange that holds the ESI probe in position next to the entrance of the heated capillary, which is part of the API stack. The ESI flange also seals the atmospheric pressure region of the API source and, when it is in the engaged position against the spray shield, compresses the high-voltage safety-interlock switch.

ESI probe A probe that produces charged aerosol droplets that contain sample ions. The ESI probe is typically operated at liquid flows of 1 μL/min to 1 mL/min without splitting. The ESI probe includes the ESI manifold, sample tube, nozzle, and needle.

ESI source Contains the ESI probe and the API stack.
See also electrospray ionization (ESI), ESI probe, and API stack.

ESI spray current The flow of charged particles in the ESI source. The voltage on the ESI spray needle supplies the potential required to ionize the particles.

ESI spray voltage The high voltage that is applied to the spray needle in the ESI source to produce the ESI spray current. In ESI, the voltage is applied to the spray liquid as it emerges from the nozzle.

See also ESI spray current.

ETD See electron transfer dissociation (ETD).
eV electron volt
**external lock mass** A lock that is analyzed in a separate MS experiment from your sample. If you need to run a large number of samples, or if accurate mass samples will be intermingled with standard samples, you might want to use external lock masses. These allow more rapid data acquisition by eliminating the need to scan lock masses during each scan.

See also **internal lock mass**.

**FT** Fourier Transformation

**FT-ICR MS** See Fourier Transform - Ion Cyclotron Resonance Mass Spectrometry (FT-ICR MS).

**FTMS** Fourier Transformation Mass Spectroscopy

**full-scan type** Provides a full mass spectrum of each analyte or parent ion. With the full-scan type, the mass analyzer is scanned from the first mass to the last mass without interruption. Also known as single-stage full-scan type.

**FWHM** Full Width at Half Maximum

**G**

**g** gram

**G** Gauss; giga (10⁹)

**GC** gas chromatograph; gas chromatography

**GC/MS** gas chromatography / mass spectrometer

**GUI** graphical user interface

**H**

**h** hour

**b** height

**handshake** A signal that acknowledges that communication can take place.

**HCD** Higher Energy Collision Induced Dissociation

**header information** Data stored in each data file that summarizes the information contained in the file.

**H-ESI source** Heated-electrospray ionization (H-ESI) converts ions in solution into ions in the gas phase by using electrospray ionization (ESI) in combination with heated auxiliary gas.
high performance liquid chromatography (HPLC)

Liquid chromatography in which the liquid is driven through the column at high pressure. Also known as high pressure liquid chromatography.

HPLC See high performance liquid chromatography (HPLC).

HV high voltage
Hz hertz (cycles per second)

I
ICR ion cyclotron resonance
ID inside diameter
IEC International Electrotechnical Commission
IEEE Institute of Electrical and Electronics Engineers
in inch

infrared multiphoton dissociation (IRMPD) In infrared multiphoton dissociation (IRMPD), multiply charged ions consecutively absorb photons emitted by an infrared laser until the vibrational excitation is sufficient for their fragmentation. The fragments continue to pick up energy from the laser pulse and fall apart further to ions of lower mass.

See also electron capture dissociation (ECD).

instrument method A set of experiment parameters that define Xcalibur operating settings for the autosampler, liquid chromatograph (LC), mass spectrometer, divert valve, syringe pump, and so on. Instrument methods are saved as file type .meth.

internal lock mass A lock that is analyzed during the same MS experiment as your sample and is contained within the sample solution or infused into the LC flow during the experiment. Internal lock masses provide the most accurate corrections to the data.

See also external lock mass.

I/O input/output

ion gauge Measures the pressure in the mass analyzer region (high vacuum region) of the vacuum manifold.

ion optics Focuses and transmits ions from the API source to the mass analyzer.

ion source A device that converts samples to gas-phase ions.

IRMPD See infrared multiphoton dissociation (IRMPD).

K
k kilo (10³, 1000)
K kilo (2¹⁰, 1024)
KEGG Kyoto Encyclopedia of Genes and Genomes
kg kilogram

L
l length
L liter
LAN local area network
lb pound

LC See liquid chromatography (LC).

LC/MS See liquid chromatography / mass spectrometry (LC/MS).

LED light-emitting diode
LHe liquid helium

liquid chromatography (LC) A form of elution chromatography in which a sample partitions between a stationary phase of large surface area and a liquid mobile phase that percolates over the stationary phase.

liquid chromatography / mass spectrometry (LC/MS) An analytical technique in which a high-performance liquid chromatograph (LC) and a mass spectrometer (MS) are combined.

LN2 liquid nitrogen
**lock mass** A known reference mass in the sample that is used to correct the mass spectral data in an accurate mass experiment and used to perform a real-time secondary mass calibration that corrects the masses of other peaks in a scan. Lock masses with well-defined, symmetrical peaks work best. You can choose to use internal lock mass or external lock mass.

**log file** A text file, with a .log file extension, that is used to store lists of information.

**M**

μ micro (10⁻⁶)

m meter; milli (10⁻³)

M mega (10⁶)

M⁺ molecular ion

**MALDI** See matrix-assisted laser desorption/ionization (MALDI).

**matrix-assisted laser desorption/ionization (MALDI)** Ionization by effect of illumination with a beam of laser generated light onto a matrix containing a small proportion of analyte. A mass spectrometric technique that is used for the analysis of large biomolecules.

MB Megabyte (1048576 bytes)

MH⁺ protonated molecular ion

min minute

mL milliliter

mm millimeter

**MRFA** A peptide with the amino acid sequence methionine–arginine–phenylalanine–alanine.

**MS** mass spectrometer; mass spectrometry

**MSⁿ power:** where n = 1

**MS scan modes** Scan modes in which only one stage of mass analysis is performed. The scan types used with the MS scan modes are full-scan type and selected ion monitoring (SIM) scan type.

**MSDS** Material Safety Data Sheet

**MS/MS** Mass spectrometry/mass spectrometry, or tandem mass spectrometry is an analytical technique that involves two stages of mass analysis. In the first stage, ions formed in the ion source are analyzed by an initial analyzer. In the second stage, the mass-selected ions are fragmented and the resultant ionic fragments are mass analyzed.

**MSⁿ scan mode** The scan power equal to 1 to 10, where the scan power is the power n in the expression MSn. MSn is the most general expression for the scan mode, which can include the following:

- The scan mode corresponding to the one stage of mass analysis in a single-stage full-scan experiment or a selected ion monitoring (SIM) experiment
- The scan mode corresponding to the two stages of mass analysis in a two-stage full-scan experiment or a selected reaction monitoring (SRM) experiment
- The scan mode corresponding to the three to ten stages of mass analysis (n = 3 to n = 10) in a multi-stage full-scan experiment or a consecutive reaction monitoring (CRM) experiment.

See also MS scan modes and MS/MS.

**multipole** A symmetrical, parallel array of (usually) four, six, or eight cylindrical rods that acts as an ion transmission device. An RF voltage and dc offset voltage are applied to the rods to create an electrostatic field that efficiently transmits ions along the axis of the multipole rods.

**m/z** Mass-to-charge ratio. An abbreviation used to denote the quantity formed by dividing the mass of an ion (in u) by the number of charges carried by the ion. For example, for the ion C₇H₇⁺²⁺, m/z = 45.5.

**N**

n nano (10⁻⁹)

**nanospray ionization (NSI)** A type of electrospray ionization (ESI) that accommodates very low flow rates of sample and solvent on the order of 1 to 20 nL/min (for static nanospray) or 100 to 1000 nL/min (for dynamic nanospray).

**NCBI** National Center for Biotechnology Information (USA)
Glossary: NIST

NIST National Institute of Standards and Technology (USA)

NMR Normal Mass Range

NSI See nanospray ionization (NSI).

octapole An octagonal array of cylindrical rods that acts as an ion transmission device. An RF voltage and dc offset voltage applied to the rods create an electrostatic field that transmits the ions along the axis of the octapole rods.

Q

quadrupole A symmetrical, parallel array of four hyperbolic rods that acts as a mass analyzer or an ion transmission device. As a mass analyzer, one pair of opposing rods has an oscillating radio frequency (RF) voltage superimposed on a positive direct current (dc) voltage. The other pair has a negative dc voltage and an RF voltage that is 180 degrees out of phase with the first pair of rods. This creates an electrical field (the quadrupole field) that efficiently transmits ions of selected mass-to-charge ratios along the axis of the quadrupole rods.

R

RAM random access memory

raw data Uncorrected liquid chromatograph and mass spectrometer data obtained during an acquisition. Xcalibur and Xcalibur-based software store this data in a file that has a .raw file extension.

resolution The ability to distinguish between two points on the wavelength or mass axis.

retention time (RT) The time after injection at which a compound elutes. The total time that the compound is retained on the chromatograph column.

RF radio frequency

RF lens A multipole rod assembly that is operated with only radio frequency (RF) voltage on the rods. In this type of device, virtually all ions have stable trajectories and pass through the assembly.

RF voltage An ac voltage of constant frequency and variable amplitude that is applied to the ring electrode or endcaps of the mass analyzer or to the rods of a multipole. Because the frequency of this ac voltage is in the radio frequency (RF) range, it is referred to as RF voltage.

RMS root mean square

ROM read-only memory

rotary-vane pump A mechanical vacuum pump that establishes the vacuum necessary for the proper operation of the turbomolecular pump. (Also called a roughing pump or forepump.)
RS-232 An accepted industry standard for serial communication connections. This Recommended Standard (RS) defines the specific lines and signal characteristics used by serial communications controllers to standardize the transmission of serial data between devices.

RT An abbreviated form of the phrase retention time (RT). This shortened form is used to save space when the retention time (in minutes) is displayed in a header, for example, RT: 0.00-3.75.

S

s second

selected ion monitoring (SIM) scan type A scan type in which the mass spectrometer acquires and records ion current at one or a few selected mass-to-charge ratio values.

See also selected reaction monitoring (SRM) scan type.

selected reaction monitoring (SRM) scan type A scan type with two stages of mass analysis and in which a particular reaction or set of reactions, such as the fragmentation of an ion or the loss of a neutral moiety, is monitored. In SRM a limited number of product ions is monitored.

See also selected reaction monitoring (SRM) scan type.

SEM secondary electron multiplier

Serial Peripheral Interface (SPI) hardware and firmware communications protocol

serial port An input/output location (channel) for serial data transmission.

sheath gas The inner coaxial gas (nitrogen), which is used in the API source to help nebulize the sample solution into a fine mist as the sample solution exits the ESI or APCI nozzle.

sheath gas flow rate The rate of flow of sheath gas into the API source. A measurement of the relative flow rate (in arbitrary units) that needs to be provided at the sheath gas inlet to provide the required flow of sheath gas to the ESI or APCI nozzle.

sheath gas inlet An inlet in the API probe where sheath gas is introduced into the probe.

sheath gas plumbing The gas plumbing that delivers sheath gas to the ESI or APCI nozzle.

sheath gas pressure The rate of flow of sheath gas (nitrogen) into the API source. A measurement of the relative flow rate (in arbitrary units) that needs to be provided at the sheath gas inlet to provide the required flow of inner coaxial nitrogen gas to the ESI or APCI nozzle. A software-controlled proportional valve regulates the flow rate.

See also sheath gas.

sheath gas valve A valve that controls the flow of sheath gas into the API source. The sheath gas valve is controlled by the data system.

signal-to-noise ratio (S/N) The ratio of the signal height (S) to the noise height (N). The signal height is the baseline corrected peak height. The noise height is the peak-to-peak height of the baseline noise.

SIM See selected ion monitoring (SIM) scan type.

skimmer A vacuum baffle between the higher pressure capillary-skimmer region and the lower pressure region. The aperture of the skimmer is offset with respect to the bore of the ion transfer capillary.

source CID A technique for fragmenting ions in an atmospheric pressure ionization (API) source. Collisions occur between the ion and the background gas, which increase the internal energy of the ion and stimulate its dissociation.

SPI See Serial Peripheral Interface (SPI).

SRM See selected reaction monitoring (SRM) scan type.

sweep gas Nitrogen gas that flows out from behind the sweep cone in the API source. Sweep gas aids in solvent declustering and adduct reduction.

See also sweep gas flow rate.

sweep gas flow rate The rate of flow of sweep gas into the API source. A measurement of the relative flow rate (in arbitrary units) to provide the required flow of nitrogen gas to the sweep cone of the API source.

See also sweep gas.

syringe pump A device that delivers a solution from a syringe at a specified rate.
Glossary: T

T  Tesla

target compound  A compound that you want to identify or quantitate or that a specific protocol (for example, an EPA method) requires that you look for. Target compounds are also called analytes, or target analytes.

TIC  See total ion current (TIC).

TMP  See turbomolecular pump.

Torr  torr

total ion current (TIC)  The sum of the ion current intensities across the scan range in a mass spectrum.

tube lens offset  The voltage offset from ground that is applied to the tube lens to focus ions toward the opening of the skimmer.

See also source CID.

Tune Method  A defined set of mass spectrometer tune parameters for the ion source and mass analyzer. Tune methods are defined by using the Tune Plus (LCQ Series, LXQ, and LTQ) or Tune Master (TSQ Quantum) window and saved as the file type .LCQTune, .LTQTune, or .TSQTune, respectively.

A tune method stores tune parameters only. (Calibration parameters are stored separately, not with the tune method.)

tune parameters  Instrument parameters whose values vary with the type of experiment.

turbomolecular pump  A vacuum pump that provides a high vacuum for the mass spectrometer and detector system.

TWA  time weighted average

U  atomic mass unit

UHV  ultra high vacuum

Ulramark 1621  A mixture of perfluoroalkoxy cyclotriphosphazenes used for ion trap calibration and tuning. It provides ESI singly charged peaks at m/z 1022.0, 1122.0, 1222.0, 1322.0, 1422.0, 1522.0, 1622.0, 1722.0, 1822.0, and 1921.9.

UMR  Universal Mass Range

V  volt

V ac  volts alternating current

V dc  volts direct current

vacuum manifold  A thick-walled, aluminum chamber with machined flanges on the front and sides and various electrical feedthroughs and gas inlets that encloses the API stack, ion optics, mass analyzer, and ion detection system.

vacuum system  Components associated with lowering the pressure within the mass spectrometer. A vacuum system includes the vacuum manifold, pumps, pressure gauges, and associated electronics.

vent valve  A valve that allows the vacuum manifold to be vented to air or other gases. A solenoid-operated valve.

vol  volume

W  width

Watt
Index

A
absolute collision energy 2-14
abundance, of lock masses 2-13
accuracy, of calibration masses 6-4
Activation page 5-11
Activation Q 2-14, 5-11, 5-13
activation type 2-14, 5-13, 8-28
α-cyano-4-hydroxy cinnamic acid 7-8
Advanced Calibration Features 2-8, 3-17
Advanced Features, in instrument setup 5-7
Advanced Scan features 2-9
AGC
stability 4-5
target compensation factor 4-3
target values 2-11, 2-19, 2-23, 8-25
All page, of the Status view 2-5
analyzer
selecting 2-9
temperature control 4-7
temperature setpoint A-4
type 2-10
vacuum 4-7
Angiotensin I
ETD MS/MS spectrum 8-29
ETD spectrum 8-26
mass scan 8-27
molecular weight 8-27
stock solution 8-39
test solution 8-40
API accessory kit 3-5, 3-7
apodization 4-7
automated run 5-2, 7-18
automatic calibration 3-2, 3-13
automatic gain control (AGC) 2-19
Automatic page
Calibrate dialog box 3-13
Tune dialog box 8-13
automatic spectrum filtering (ASF) 7-5
automatic tune, recommended settings 3-10
autotuning, the reagent ion source 8-7, 8-12

B
back lens
offset 8-5
potential 8-13
Back Multipole DC Offset voltage 8-18
bakeout procedure 2-22
Br, in molecules 5-7
brightness and contrast, of the video camera 7-16
burnout, of filament 8-9

C
Calibrate dialog box
Automatic page 3-13
Check page 3-18
FT Manual page 3-21, 7-13–7-15
Semi-Automatic page 3-15–3-17, 7-10
calibration
automatic 3-13
automatic check settings 3-18
FT manual calibration 3-21, 7-13
ion trap 3-9
negative ion mode 3-19
parameters 3-2, 4-12
positive ion mode 3-19
procedures 3-2
quadrupole mass filter 8-18
reagent ion selection 8-21
semi-automatic calibration 3-15, 7-10
values 3-3
calibration checks 3-18, 7-13
readback 3-20
calibration files
backups 3-3
content 4-3
history 3-3
calibration masses 3-8, 3-22, 7-14
accuracy 6-4
calibration solutions
customized 7-14
FT manual calibration 3-8
negative mode 3-7–3-8, 3-11, 3-22
ordering 3-4
preparing 3-4
calmix 3-22
camera 7-7
centroid format 2-15
changes, in the ambient temperature A-4
changing, instrument settings 4-11
Charge State page, of Data Dependent Settings dialog box 5-7
charge states
determination 5-3
HCD 2-14–2-15
peaks 2-4
recognition 5-6
rejection 5-5
Index: D

Check page 3-18
checking, for reagent contamination 8-6
checks
calibration 3-18
mass duration 4-11
chemicals, ordering 3-5
CI gas 8-14, 8-16
CID 2-14
Cl, in molecules 5-7
cleaning, impure sample surfaces 7-5
collision energy 3-20
collision gas, for HCD 4-7
compensation factor 4-3
complex isotopic pattern 5-7
compressed profile format 2-15
configuration changes 6-3
Control menu 2-8
converting, masses to mass-to charge ratios 5-3
cooling gas 8-8–8-9
Current Scan Event page 5-8–5-9
Current Segment page 5-6

data dependent FT SIM scan 5-8
data dependent settings
charge state 5-7
current segment 5-3, 5-6
Data Dependent Settings dialog box, Activation page 8-37
data formats
storage 2-24
switching formats 2-15
data sizes, of FT spectrum A-4
DC Offset 8-21
declare scan
analyzer type 2-10
inject time 2-11
locking feature 2-12
mass range 2-10
recommended settings for automatic ion trap tuning 3-10
resolution 2-10
scan rate 2-10
scan time 2-11
scan type 2-10
Define Scan dialog box 2-9, 3-10
diagnostic views 2-4
Diagnostics dialog box, Toggles page 4-6
Display menu 2-17
Display page, of Configuration dialog box 7-20, 8-8
Display Settings page 4-12
displaying, instrument settings 4-12
dynamic exclusion 5-4, 5-7
dynamic range 2-20
dynamics of ions, in HCD collision cell 4-3

E
editing, lock mass lists 2-12, 2-22
electron energy 8-14, 8-16
electron multiplier calibration 3-14, 7-13
electron multiplier gain calibration 3-9
emission current 8-14, 8-16, 8-26
enabling
HCD collision gas 6-3
injection waveforms 2-20
error message 8-26
ESI parameters 2-24
ETD AGC target 8-25
ETD infusion experiment 8-25
ETD Module
  powering on 8-10
  service switch 8-10
exclusion mass widths 5-4
external calibration 2-12, 5-2, 7-18
external mass accuracy 4-5

F
 filament
  activating 8-6
  life time 8-16
  lifetime 8-6
  status 8-3
firmware version, of MALDI source 7-21
fluoranthene 8-8
  mass spectrum, of radical anion 8-11
frequency spectrum 4-9
FT analyzer
  automatic calibration 3-16
  information in scan header A-2
  ion gauge 4-7
  messages A-3
  settings A-2
  target values 2-20
  temperature control 4-7
FT apodization 4-7
FT calibration
  displaying settings 4-12
  modes 3-15
  procedures 3-13
FT diagnostcs, displaying 4-12
FT dynamic range test 4-2
FT Electronics switch 8-10
FT HCD page 5-12
FT include transients 4-7
FT injection waveforms 2-21
FT instrument calibration 4-11
FT instrument settings 4-13
FT isolation test 4-3
FT lockmass abundance 4-11
FT manual calibration 3-21
FT manual mass calibration, checks 4-11
FT Manual page 3-2, 3-8, 3-21, 7-9, 7-14–7-15
FT mass calibration 3-2, 3-14, 3-20–3-21, 4-3, 7-13
  automatic calibration 3-16
FT Mass Lists page 6-4
FT mass spectrum, resolution 2-10
FT MSn scans 4-8
FT noise test 4-3
FT optics values 4-11
FT page, of Injection Control dialog box 7-4
FT preamplifier evaluation 4-3
FT profile mode 4-8
FT sensitivity test 4-4
FT Settings page 6-3–6-4, 7-20–7-21, 8-9
FT SIM scans 5-8
  injection waveforms 4-8
FT spectrum, label of x-coordinate 4-9
FT stability test 4-4–4-5
FT storage multipole RF 4-9
FT storage transmission 3-2, 3-17, 3-19
FT target values 2-20
FT Temperature Control Evaluation 4-5
FT Temperature Monitor
dialog box 2-22
evaluation 4-5
icon 2-22
FT TIC 4-4
FT transfer multipole RF 4-9
FT transfer optics 2-18
FT Transfer Optics icon 2-18
FT transfer parameters 2-18
FT transmission calibration 2-8, 2-18, 3-2, 3-17, 3-20–3-21, 7-9
FT Turbopump 4-8-3
FT vacuum 2-21
FT view frequency 4-9
FT zero offset 4-9
FTMS analyzer
  signal detection path 4-3
temperature 2-22, A-4
Full MS target 2-20
full noise band 4-9
Full Profile format 4-8–4-9

HCD
activation type 2-14, 5-11
charge state 2-15, 5-13
collision energy 3-16, 3-20, A-3
collision energy calibration 7-10
collision gas 4-7, 6-3
dynamics of ions 4-3
enabling, collision gas 6-3
scan ranges 2-15
transmission 3-16–3-17, 3-20
transmission calibration 3-20, 7-10
high charge states 5-6
high mass accuracy measurements 4-5
High Mass Range
calibration 7-8
  semiautomatic calibration 7-12
high mass range mode 4-3
high voltage electronics A-3
high voltage pulser 4-4

I
infusion experiment 4-2–4-4
inject time 2-11, 3-11
injection control
  FT target values 2-20
  ion trap target values 2-19
Injection Control dialog box 2-19, 4-8
  Reagent page 8-25
injection waveforms 2-21, 4-8
  enabling/disabling 2-19–2-20
  flags 2-24
inlet valve block 8-6
in-source fragmentation 3-11
Instrument Configuration dialog box 6-2, 7-19–7-20, 8-8
instrument method 2-24
instrument reset 4-11
instrument settings, displaying 4-12
Instrument Setup 5-1–5-3, 7-18
intensity, of peaks 5-7
internal peak detection overflow A-4
internal reference 2-12
ion energy 4-2
ion mode 2-16
ion optic supply board 4-9
ion polarity
  changing 2-16
  mode 2-23
Ion Source page, of Configuration dialog box 7-20
ion trap
  automatic calibration 3-16
  calibration 3-9
spectrum, of negative mode calibration solution 3-11–3-12
target values 2-19
tuning, recommended settings 3-10

G
glacial acetic acid 3-6, 3-8
Global page 5-3
Graph view 2-5

H
HCCA matrix 7-8
Index: L

isolation/fragmentation efficiency 2-20
isotope exclusion 5-4
isotopic cluster recognition 5-7

L
laser
   energy 7-4–7-5
   information 7-2
last successful check 3-20
lens parameters 8-16
lifetime, of filament 8-6
lock mass abundance 2-13, 4-11
Lock Mass List button 5-2, 7-18
lock mass lists 2-12, 2-22
lock mass settings A-3
lock masses 2-12, 5-2
Lock Masses dialog box 2-13, 2-22, 5-2
locking
   availability 2-12
   in automated runs 5-2, 7-18
LTQ Orbitrap XL Configuration dialog box
description 6-2
FT Mass Lists page 6-4
FT Settings page 6-3–6-4, 7-20–7-21, 8-9

M
MALDI
   firmware version, of source 7-21
   serial number, of source 7-21
   source specification 7-8
MALDI page, in the Diagnostics dialog box 7-16
MALDI Source Configuration dialog box 7-21
MALDI Source dialog box
   Acquire page 7-6
   Camera page 7-7
   Control page 7-4
   displaying 7-4
   Setup page 7-5
manual toggles A-2
mass accuracy 2-20, 4-5
mass calibration 4-2
   check 7-10
mass deltas 5-4
mass differences 5-4
mass lists 3-22, 6-4–6-5
mass range 2-10, 5-4
   coverage 4-8
mass-to-charge ratio, as mass 5-3
mass-to-charge ratios 3-22
Material Safety Data Sheet (MSDS) 8-39
maximum AGC target value 4-3
maximum inject time 2-11, 2-23, 7-3, 8-25
microscans 2-11, 2-23
monoisotopic peaks 5-8
monoisotopic precursor selection 5-7–5-8
MRFA
   alone solution 4-2–4-3
   signal 4-2
MS Charge State 5-5
MS Detector Setup page 5-2
MSs scans, injection waveforms 4-8
MSn settings 2-14
MSn target 2-20
multiplier gain calibration 3-14

N
negative ion mode 3-11, 3-15–3-16
   checking calibration 3-19
negative mode calibration solution 3-8, 3-11, 3-22
   preparing 3-7
neutral loss mass widths 5-4
non-peptide monoisotopic peak recognition 5-8
number, of reagent ions 8-4

O
Orbitrap
   chamber temperature 6-3
   checking the calibration 3-19
   selecting as analyzer 2-10
ordering
   calibration solutions 3-4
   ordering chemicals 3-5
overriding calibration values 4-11

P
parameters, of vacuum system 2-21
parent mass list 5-5
parent mass widths 5-4
peaks
   charge state 2-4
   intensity 5-7
   labels 2-4
performing, diagnostics/checks 4-1
plate
   motion 7-4
   position 7-6
positive ion mode
   calibration solution 3-6
   checking calibration 3-19
   FT calibration 3-15
PQD 2-14
preamplifier
evaluation 4-3
input protection switches 4-4
pressure, in the upper and the lower chamber 7-2
preview mode 5-6
product
  mass list 5-5
  mass widths 5-4
product ion mass 8-31
product ions 8-30
profile format 2-15
ProteoMass MALDI Calibration Kit 7-8

Q
Q value 2-14
quadrupole mass filter 8-21, 8-24

R
readback values 4-12
reagent ion intensity 8-6, 8-16
Reagent Ion Isolation 8-19
reagent ion optics
  parameters 8-5
  settings 8-17
Reagent Ion Optics dialog box 8-5, 8-18
Reagent Ion Optics icon 8-2, 8-14–8-15
reagent ion peaks 8-11
Reagent Ion Reaction Time 8-29
reagent ion source
  status 8-3
  turning on 8-10
Reagent Ion Source dialog box 8-5, 8-10
Reagent Ion Source instrument control icon 8-2–8-3, 8-10
Reagent Ion Source Tune dialog box, Manual page 8-16
reagent ion spectra 8-11
Reagent page
  Injection Control dialog box 8-4, 8-25
  Vacuum dialog box 8-7
reagent signal intensity 8-13
reagent turbopump 8-3
reagent vacuum 8-3
reagent vials 8-6, 8-8
Reduced Profile format 4-8–4-9
rejecting
  mass lists 5-5
  mass widths 5-4
reserpine 4-4
resistant noise peaks 4-3
resolution
  of FT mass spectrum 2-10
  of FTMS scan 5-6
RF amplitude value A-3

Roadmap Home Page 8-33

S
safety problem, in the laboratory 8-9
sample plate 7-6
saving, ETD Tune parameters 8-18
scan cycle time 8-26
scan description 2-10
scan events 8-35
scan header 4-6, 4-8, A-2
Scan Mode menu 2-9
scan range settings A-3
scan ranges, in HCD experiment 2-15
scan rate 2-10
scan time 2-11
Scan Time Settings dialog box 2-11
scan type 2-10
scan width 5-10
selecting
  analyzer type 2-9
  calibration masses 3-2
  devices 4-10
  experimental parameters 4-10
semi-automatic calibration 3-2, 3-15, 7-10
semi-automatic mass calibration, frequency 7-10
Semi-Automatic page, of the Calibrate dialog box 2-8, 3-15–3-16
sensitivity, of reagent ion source 8-26
serial number, of MALDI source 7-21
Set device page 4-10, 4-13
settings, of manual toggles A-2
Setup menu 2-18
shortcut menus
  Spectrum view 2-3, 4-7
  User page 2-6
signal-to-noise ratio 4-2
SIM
  injections 2-13
  target 2-20
Small Mass Range 7-8
Sn, in molecules 5-7
sodium dodecyl sulfate 3-7
sodium taurocholate 3-7
spectrum averaging 2-17
Spectrum Display Options dialog box 2-4
Spectrum view 2-3
  display options 2-3
  shortcut menu 2-3, 4-7
stabilization time A-3
starting, instrument configuration 6-2, 7-19
Status box, of Tune dialog box 8-31
Status view 2-5
stock solutions
Index: T

Angiotensin I 8-39
MRFA 3-5, 3-7
sodium dodecyl sulfate 3-7
sodium taurocholate 3-7
Ultramark 1621 3-6
storage multipole 3-19
storage transmission 2-8, 3-17
calibration 3-19, 3-21, 7-10
supplemental activation 8-4
sweep laser shots 7-5
sweet spots 7-7
switching, data formats 2-15
syringe pump 4-11
System Evaluation page 4-2, 7-16
system performance 4-2

tune methods 2-23
Tune Plus window 2-1–2-2, 3-3, 7-2, 8-2
   Display menu 2-17
   Scan Mode menu 2-9
   Setup menu 2-18
   version 1-1
   View menu 2-3
tuning
   ETD Reagent Ion Optics settings 8-12
   ion trap for negative ion mode 3-11
   ion trap for positive ion mode 3-9
   reagent ion source 8-14

U
Ultramark 1621 3-7
Universal Mass Range 7-8
User page, of the Status view 2-5
User Status Display Configuration dialog box 2-5–2-7

V
vacuum
   icon 2-21
   system parameters 2-21
Vacuum dialog box 2-21
vial heaters 8-6
video camera 7-16
View menu 2-3
views
   Graph view 2-5
   Spectrum view 2-3
   Status view 2-5

X
Xcalibur instrument method 8-33
Xcalibur raw file 4-7